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About this manual

1 About this manual

The manual shows the information necessary to:
- commission
- operate
- carry out maintenance on

the VIS 2.5 to 30 kVA.
- 2.5 to 15 kVA: small cabinet
- 20 to 30 kVA: big cabinet.

If in the manual the term equipment is used, this refers to both the small and the big cabinet.

1.1 How to work with the manual
1. Familiarize yourself with the structure and content.
2. Carry out the actions completely and in the given sequence.

1.2 Record of changes
 

1.3 Icons used in the manual
For all WARNING symbols, see chapter § 2.

 

Edition Editor Check Date Description

1.0 MR AHU, 
MAW, 
VDV

09/2011 New

2.0 TWE 06/2017 Added mechanical improvements. Layout changes

CAUTION
Can cause damage to the equipment.

NOTE
Gives further information.
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About this manual

1.4 Abbreviations and terms
 

Table: 1.1 Terms and abbreviations

Term or abbreviation Description

AC Alternating Current

AGL Airfield Ground Lighting

CENELEC Comitée Eruopéen de Normalisation ELECtrotechniqe (European Committee 
for Electrotechnical Standardization)

CS Circuit Selector

CSM Circuit Selector Module

DC Direct Current

DSP Digital Signal Processor

EFD Earth Fault Detection

EMC Electro Magnetic Compatibility

Equipment The stackable, the small cabinet and big cabinet, if the information is the 
same

FAA Federal Aviation Administration

FDT Flash Development Toolkit

HMI Human-Machine Interface

HV High Voltage

ICAO International Civil Aviation Organisation

IGBT Insulated Gate Bipolar Transistor

LFD Lamp Fault Detection

MW Multiwire

PC Personal Computer

PCB Printed Circuit Board

PIC A controller from Microchip. 

PVC PolyVinylChloride

PWM Pulse Width Modulation

PE Protective Earth

Remote control system The remote control system in the airport to control the equipment on the field.

RMS Root Mean Square

SCB Series Connector Box

SCO Series Cut Out

SHVS Servo High Voltage Switch
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Safety

2 Safety

Read all warnings carefully. Failure to do so may result in personal injury, death, or property damage.

2.1 Use
To use the equipment safely:

Refer to the International Standard IEC 61820, Electrical installation for lighting and beaconing of 
aerodromes - Constant current series circuits for aeronautical ground lighting - System design and 
installation requirements, and to the International Standard IEC 61821, Electrical installations for lighting 
and beaconing of aerodromes - Maintenance of aeronautical ground lighting circuits for instructions on 
safety precautions.
See FAA Advisory Circular AC 150/5340-26, Maintenance of Airport Visual Aids Facilities, for additional 
instructions on safety precautions.
Observe all safety regulations. To avoid injuries, always remove power prior to making any wire 
connections and touching any live part. Refer to the International Standards IEC 61820 and IEC 61821.
In addition for a parallel power supply also take into account the International Standard IEC 60598 (for 
class I equipment).
Read and become familiar with the general safety instructions provided in this chapter before you install, 
operate, maintain or repair the equipment.
Read and carefully follow the instructions given throughout this manual before installing, operating, 
maintaining, or repairing the equipment.
Store this manual within easy reach of personnel installing, operating, maintaining or repairing the 
equipment.
Follow all applicable safety procedures required by your company, industry standards, and government 
or other regulatory agencies.
Obtain and read Material Safety Data Sheets (MSDS) for all materials used.

2.2 Safety symbols
Become familiar with the safety symbols presented in this chapter. These symbols will alert you to safety 
hazards and conditions that may result in personal injury, death, or property and equipment damage.

 

WARNING 1: Failure to observe this warning may result in personal injury, death, or equipment 
damage.

WARNING 2: Risk of electrical shock. Disconnect equipment from line voltage. Failure to 
observe this warning may result in personal injury, death, or equipment damages.

WARNING 3: Wear personal protective equipment. Failure to observe may result in serious 
injury.

WARNING 4: Do not touch. Failure to observe this warning may result in personal injury, death, 
or equipment damage.
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2.3 Signs on the equipment

The signs on the equipment are part of the safety provisions. Do not cover or remove the signs. The signs 
must be present and legible during the entire life of the equipment.

2.4 Skilled personnel
The term skilled personnel is defined here as individual who thoroughly understand the equipment and its 
safe operation, maintenance, and repair. Skilled personnel are physically capable of performing the required 
tasks, familiar with all relevant safety rules and regulations and have been trained to safely install, operate, 
maintain, and repair the equipment. It is the responsibility of the company operating the equipment to see 
that its personnel meet these requirements.

2.5 Liability

ADB Safegate cannot be held responsible for injuries or damages resulting from non-standard, unintended 
uses of its equipment. The equipment is designed and intended only for the purpose described in the 
manual. Uses not described in the manual are considered unintended uses and may result in serious 
personal injury, death or property damage.

DANGER

HAUTE TENSION HIGH VOLTAGE
COUPER LE REGULATEUR
SWITCH REGULATOR OFF

UNLOCK BEFORE OPENING
LINE VOLTAGE : 5000 V.AC. MAX
SERIES CURRENT : 20A.AC. MAX

PN : 1475 92.030

CUTOUT TYPE SCO

DANGER
HAUTE TENSION HIGH VOLTAGE

COUPER L’ALIMENTATION AVANT
TOUTE VERIFICATION OU REPARATION

ALWAYS SWITCH EQUIPMENT OFF
BEFORE INSPECTION OR REPAIR 

 High leakage current!
Earth connection

essential before connecting
supply and load

Warning!
Switch off the CCR before

connecting or disconnecting
the remote control link

WARNING
Use of the equipment in ways other than described in the catalogue leaflet and the manual 
may result in personal injury, death, or property and equipment damage. Use this 
equipment only as described in the manual.
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Unintended uses includes the following actions:
Making changes to equipment that have not been recommended or described in this manual or using 
parts that are not genuine ADB Safegate replacement parts or accessories.
Failing to make sure that auxiliary equipment complies with approval agency requirements, local codes, 
and all applicable safety standards if not in contradiction with the general rules.
Using materials or auxiliary equipment that are inappropriate or incompatible with your ADB Safegate 
equipment.
Allowing unskilled personnel to perform any task on or with the equipment.

2.6 Installation
Read the installation section of all system component manuals before installing your equipment. A thorough 
understanding of system components and their requirements will help you install the equipment safely and 
efficiently.

Allow only skilled personnel to install ADB Safegate and auxiliary equipment. Use only approved 
equipment. Using unapproved equipment in an approved system may void agency approvals and will 
void the warranty.
Make sure all equipment is rated and approved for the environment in which you are using it.
Follow all instructions for installing components and accessories.
Install all electrical connections to local code provided they are not in contradiction with the general rules.
Use only electrical wire of sufficient gauge and insulation to handle the rated current and voltage 
demand. All wiring must meet local codes.
Route electrical wiring along a protected path. Make sure they will not be damaged by moving equipment 
and animals (e.g. rodents).
Protect components from damage, wear, and harsh environment conditions.
Allow ample room for maintenance, panel accessibility (power products), and cover removal (power 
products).
Protect equipment with safety devices as specified by applicable safety regulations.
If safety devices must be removed for installation, install them immediately after the work is completed 
and check them for proper functioning.

2.7 Operation
Only skilled personnel, physically capable of operating the equipment and with no impairments in their 
judgment or reaction times, should operate this equipment.

Read all system component manuals before operating the equipment. A thorough understanding of system 
components and their operation will help you operate the equipment safely and efficiently.

Before starting this equipment, check all safety interlocks and protective devices such as panels and 
covers. Make sure all devices are fully functional. Do not operate the equipment if these devices are not 
working properly. Do not deactivate or bypass automatic safety interlocks or locked-out electrical 
disconnects or pneumatic valves.
Never operate equipment with a known malfunction.
Do not attempt to operate or service electrical equipment if standing water is present.
Use the equipment only in the environments for which it is rated. Do not operate the equipment in humid, 
flammable, or explosive environments unless it has been rated for safe operation in these environments.
Never touch exposed electrical connections on equipment while the power is ON. Make sure the exposed 
electrical connections are proven to be dead.

WARNING
Failure to follow these safety procedures can result in personal injury or death.
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2.8 Action in the event of an equipment malfunction

Do not operate a system that contains malfunctioning components. If a component malfunctions, turn the 
system OFF immediately.
1. Disconnect and lock out electrical power.
2. Allow only skilled personnel to make repairs. Repair or replace the malfunctioning component according 

to instructions provided in its manual.

2.9 Maintenance and repair
Allow only skilled personnel to perform maintenance, troubleshooting, and repair tasks. Only persons who 
are properly trained and familiar with ADB Safegate equipment are permitted to service the equipment.

Always use safety devices when working on the equipment.
Follow the recommended maintenance procedures in your equipment manuals.
Do not service or adjust any equipment unless another person trained in first aid and Cardio Pulmonary 
Resuscitation (CPR) is present.
Connect all disconnected equipment ground cables and wires after servicing equipment. Ground all 
conductive equipment.
Use only approved ADB Safegate replacement parts. Using unapproved parts or making unapproved 
modifications to equipment may void agency approvals, impair specified performance and create safety 
hazards.
Check interlock systems periodically to ensure their effectiveness.
Do not attempt to service electrical equipment if standing water is present. Use caution when servicing 
electrical equipment in a high-humidity environment.
Use tools with insulated handles when working with electrical equipment.

2.10 CE certification
The equipment is CE certified. It means that the product complies with the essential requirements 
concerning health and safety. The directives that have been taken into consideration in the design are 
available on written request to ADB Safegate.

2.11 Guarantee
ADB Safegate guarantees that the performance of the equipment described in this manual, when sold by 
ADB or its licensed representatives, meets the corresponding requirements of FAA, ICAO and IEC.

Refer to the document ‘General Conditions for Deliveries and Services by ADB Safegate.
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3 Description

3.1 Series circuit system overview

A Input power supply
B Manual switch
C Remote control system

D Equipment
E Output disconnection device
F Series circuit

The equipment is a microprocessor-controlled constant current regulator.

3.2 Intended use
The equipment is designed to convert an AC sine wave input voltage into an adjusted output current 
selected in brightness steps to supply a series AGL circuit.
Any other or additional use will be considered not to be in conformity with the purpose.

Do not operate the equipment outside the limits of the specifications or outside the specified ambient 
conditions.

A B D

C

E F
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3.3 Working principle

A Line input. See § 3.5.1
B Precharge PCB. See § 3.5.1.
C Diode bridge and sensing PCB. See § 3.5.2.
D Capacitor bank. See § 3.5.3
E IGBT module and IGBT PCB. See § 3.5.2.
F Output filter. See § 3.5.5.
G Main transformer. See § 3.5.6
H Output measure PCB. See § 3.5.7
I Lightning arrestors. See § 3.5.8
J Series output connection. See § 3.5.8
K CPU PCB. See § 3.5.9
L HMI. See § 3.7
M Remote control PCB. See § 3.5.10
N Power supply PCB. See § 3.5.11

Legend
- Red lines: current
- Green lines: signal wires connections
- Black lines: low voltage connections

Current regulation
The equipment converts the three phase input voltage line into a DC current and voltage. Then, the 
equipment converts this DC current and voltage into a pure sine wave with a defined power rating.

Main feedback loop
The output measure PCB sends the measured output to the micro control PCB. Depending on the output, 
the micro control PCB automatically generates signals to adjust the regulation.

OUT
C D E F G H

I
J

M

K

L
1

5

9

5

9

2

6

0

3

7
.

4

8
CANCEL

ON

REMOTE

OFF

ENTER

LOCAL

A
IN

N

B
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3.4 Lay-out of the equipment cabinets

3.4.1 Outside - small cabinet: 2.5 to 15 kVA

A Ventilation grids 
B HMI 
C Serial communication port
D Manual switch
E Remote control connector
F Series output connection. The illustration shows the SCO.
G Output to Series Circuit
H Ethernet connector
I Power supply cable entry

C

A

A

B

D

A

A

I

G

F

E

H

A A
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3.4.2 Inside - small cabinet: 2.5 to 15 kVA

A CPU PCB (EPS479)
B Main fuses
C Main contactor
D Precharge contactor
E IGBT module and IGBT PCB (EPS477)
F Precharge PCB
G Diode bridge and sensing PCB (EPS 540 / EPS541)
H Power supply PCB (EPS480)
I Output filter
J Remote control PCB (EPS495) 
K Lightning arrestors
L Output measure PCB (EPS422)
M Input terminals
N Line filter
O Main transformer
P Capacitor Bank
Q Power supply transformer
R Sensing transformer

Note
The illustrations shows the 5 kVA cabinet.

J

I

K

L

M

N

OQR P

A
B

C
D

F
G
H

E
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3.4.3 Outside - big cabinet 20 to 30 kVA

A Ventilation grids
B HMI
C Serial communication port
D Manual switch
E Remote control connector
F Series output connection. The illustration shows the SCO.
G Output to Series Circuit
H Ethernet connector
I Power supply cable entry

B

C

D

A

A

A

I

G

F

E

H

A

A A
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3.4.4 Inside - big cabinet 20 to 30 kVa 

A Line filter
B Output filter
C Power supply PCB (EPS480)
D Sensing transformer
E Power supply transformer
F CPU PCB (EPS479)
G Sensing PCB (EPS497)
H Diode bridge
I Precharge PCB (PCB456)
J Main fuses
K Main contactor
L IGBT module
M IGBT PCB (EPS496 / EPS478)
N Precharge contactor
O Capacitor bank
P Lightning arrestors
Q Remote control PCB (EPS495)
R Output measure PCB (EPS422)
S Input terminals
T Main transformer

Note
The illustrations shows the 20 kVA cabinet.

B

Q

R

S

T

PA

J

K

NO O

L

M

G
H
I

F
E

C
D
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3.5 Components
For the exact location and connectors see § 3.4 and the electrical scheme. You can find the electrical 
scheme in the document holder inside the equipment.

3.5.1 Line input

Input terminal, all cabinets
The input terminal connects the power input cables to the 
equipment.

Line filter, all cabinets
The line filter blocks the noise the equipment generates to the 
line input and filters out voltage pulses from the input voltage.

Manual switch, all cabinets
The manual switch is a magneto-thermal switch that connects 
the mains power supply to the equipment. You can manually set 
the switch to the ON or OFF position.
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Main fuses, small cabinet
The main fuses disconnect the equipment from the mains power 
supply if the input current is above a given value.

Main fuses, big cabinet
The main fuses disconnect the equipment from the mains power 
supply if the input current is above a given value.

Main contactor, small cabinet
The main contactor allows the power supply PCB to 
automatically interrupt the power.
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Main contactor, big cabinet
The main contactor allows the power supply PCB to 
automatically interrupt the power.

Precharge contactor, small cabinet
The precharge contactor allows a smooth charge of the 
capacitors on the capacitor bank.

Precharge contactor, big cabinet
The precharge contactor allows a smooth charge of the 
capacitors on the capacitor bank.
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Description

Precharge PCB (EPS456), all cabinets
The resistors on the precharge PCB limit the current for the 
precharge of the capacitor bank.

Sensing transformer, all cabinets
The sensing transformer measures the difference in the input 
voltage level between phases L1 and L2.

Power supply transformer, all cabinets

The power supply transformer
- Measures the input voltage level between phases L2 and L3.
- Provides the correct current and voltage to power all the 

electronic components such as PCBs and to power the fans 
(for 15 to 30kVA equipment)
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3.5.2 IGBT power bridge

Diode bridge + sensing PCB (EPS540 / EPS541), small cabinet
The diode bridge converts the AC line input to a rectified current 
and voltage.
The sensing PCB measures the AC input line.

Sensing PCB (EPS497), big cabinet
The sensing PCB measures the AC input line and controls the 
diode bridge.

Diode bridge, big cabinet
The diode bridge converts the AC line input to a rectified current 
and voltage.

Note
In the small cabinet, the sensing PCB and the 
diode bridge are combined into one part.

Note
In the big cabinet, the sensing PCB and the diode 
bridge are separate parts.

Note
In the big cabinet, the sensing PCB and the diode 
bridge are separate parts.
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IGBT, all cabinets
An IGBT controls a high power via a low power electronic signal. 
The IGBT can switch at high frequency.
Two IGBTs are installed together in one housing.
The system uses four IGBTs connected as an H-bridge to make 
an AC-signal. 

IGBT PCB (EPS477 / EPS496 / EPS 478), all cabinets
The IGBT PCB measures the output signal from the IGBT H-
bridge. 

3.5.3 Capacitor bank
The capacitor bank smoothens the DC current and voltage to make a constant DC current and voltage.

Capacitor bank, small cabinet
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Capacitor bank, big cabinet

3.5.4 Hall sensor, big cabinet
The Hall sensor measures the current between the IGBT and the 
output filter.

3.5.5 Output filter

Output filter, small cabinet 
The output filter is a Pulse Width Modulation (PWM) filter that 
builds the pure sine wave signal that comes from the H-bridge.
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Output filter, big cabinet
The output filter is a Pulse Width Modulation (PWM) filter that 
builds the pure sine wave signal that comes from the H-bridge.

3.5.6 Main transformer, all cabinets
The main transformer converts the pure sine wave to the correct 
output voltage and current.

3.5.7 Output measure PCB (EPS422), all cabinets
The output measure PCB measures the output voltage and 
current and sends these measurements to the CPU PCB.
The EFD (See § 3.5.13) and LFD (See § 3.5.12) logic is also 
located on the output measure PCB. 
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3.5.8 Power output

Lightning arrestors, all cabinets
The lightning arrestors are installed on the power output. The 
lightning arrestors are varistors.
A varistor is a surge protection device that is connected directly 
across the AC output. 

Connection to the series circuit
There are mutual exclusive options possible. See §3.6.

3.5.9 CPU PCB (EPS479), all cabinets

The CPU PCB
- Receives the measurement data of the output current and 

voltage from the output measure PCB via an optical fibre and 
compares these values with the required values. A software 
algorithm processes this data to adjust the signals from the 
output filters.

- Receives and processes input signals from the HMI and the 
remote control PCB.

3.5.10 Remote control PCB (EPS495), all cabinets

The equipment can be monitored or controlled remotely with J-
Bus (2-wire RS485), multiwire or ethernet (option). This remote 
control allows the remote control system to:
- Receive information about the equipment.
- Configure the brightness steps.
- Test the equipment.

The remote control PCB connects the equipment to the remote 
control system. The internal connection between the remote 
control PCB and the CPU PCB goes through an optical fibre.

Note
For remote control through an ethernet 
connection, an additional ethernet PCB is required. 
See § 3.6.2.
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3.5.11 Power supply PCB (EPS480), all cabinets

The power supply PCB provides the power supply for:
- All electronic components such as PCBs of the equipment.
- The fans (for 15 to 30 kVA equipments).
- The control for the main contactor.

The power supply PCB also manages the safety switches on the 
panels.

3.5.12Lamp Fault Detection (LFD)
The equipment analyses the output current and the voltage pattern to calculate, on a linear load, the number 
of open circuited lamps, in compliance with IEC 61822.

The accuracy is ± 1 lamp with a range from 1 to 15 broken lamps.

The HMI shows the actual LFD value.

3.5.13Earth Fault Detection (EFD)
The EFD measures the insulation resistance between the series circuit and the earth in compliance with IEC 
61822.

The EFD module works when the equipment is connected to the mains supply, even if no output current is 
present.

You can set two alarm levels, Level 1 and Level 2, for the measured values. Both alarm levels can be set to 
any value between 5 kOhm and 500 MOhm. However, Level 1 must always be higher than Level 2.

Working principle: A high-voltage resistor applies a stable, current-limited voltage of 450 VDC between the 
series circuit and the earth or cable screen.

The HMI shows the actual EFD value.

3.5.14Ventilation
The equipment has air ventilation grids for air inlet and air outlet. The air circulation cools the equipment.
For 15 to 30 kVA equipments, additional fans cool the equipment.

3.6 Options

3.6.1 Remote control
These remote control connections are possible:
- Ethernet (Ethernet PCB required)

- Single
- Double

- J-Bus
- Single
- Double

- Multiwire with 8 input signals and 17 output signals, always possible to monitor via single J-Bus
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3.6.2 Ethernet PCB (EPS542), all cabinets
The ethernet PCB converts the ethernet to an RS-485 signal. This 
PCB is required if you need to remotely operate the equipment 
through an ethernet connection. 
The illustration shows a double ethernet connection.

3.6.3 Series Connector Box (SCB), all cabinets
The SCB connects the equipment to the series circuit with two 
medium voltage cables of the primary circuit. The SCB does not 
allow the short circuit connection.

3.6.4 Series CutOut (SCO), all cabinets
The SCO acts as an output disconnection device between the 
equipment and the series circuit. The SCO also isolates the series 
circuit from the equipment during maintenance or testing 
operations. The cover is locked with a key to prevent unauthorized 
access.
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3.6.5 Rolling castors
The equipment can be supplied with two fixed and two pivoting rolling castors to facilitate the movement of 
the equipment.

3.7 HMI
You can operate the equipment with the HMI.

3.8 Nameplate
Each equipment has a standard nameplate:
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4 Description of the HMI

4.1 HMI overview

A Display
B Function buttons
C Keypad
D ON, OFF, ENTER, CANCEL REMOTE and 

LOCAL buttons
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4.2 Display overview: Main screen

 

Table: 4.1 Display description: Main screen

Name Description

A Menu Push the corresponding function button to go to the Main menu.

B Mode indication Shows the state, LOCAL or REMOTE.

C State The state can be OFF or ON.

D Brightness level OFF, or BRIGHTNESS 0 to 5. Optionally, more levels are possible.
If the display shows BRIGHTNESS 0, this means that the equipment has a pre-
defined current as output, due to a remote control loss.

E Field circuit Shows the name of the field circuit that the equipment delivers power to. 

F True RMS output 
voltage

Shows the true RMS output voltage in kV.

G True RMS output 
current

Shows the true RMS output current in A.

H Highest brightness 
step counter

Shows the time that the equipment operates at the maximum brightness step 
in h.

I Total brightness 
counter

Shows the total time that the equipment is set to ‘on’ in h.

J EFD indicator Shows the measurement of the resistance to earth. The equipment continuously 
measures the value, also when the equipment is in the OFF state, when the 
equipment has power.

K LFD indicator In normal mode (linear load): Shows the number of broken lamps if the LFD is 
calibrated.
In inductive mode (non-linear load): Shows the text ‘inductive’ 

L Software version Shows the current software version.

M Power rating Shows the power rating of the equipment.

RUNWAY
V :0.00KV
I  :0.00A

HOURS:68
H_TOT :256
EFD: 5.8 Mohm
LFD: - - -

OFF
OFF

STATE:

LOCAL
5KVA  -  Rel. 4.00MENUA
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G
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4.3 Description of general functions
The function buttons can have different functions. The display description show the dedicated functions. This 
section shows the general functions, which are available in several menus. 

 

Table: 4.2 General function buttons

4.4 Main menu

 

Table: 4.3 Display description: Menu screen

Button Description

→ To go to the next submenu.

← To go to the previous submenu.

ESC To go to the higher level menu.

- To decrease the value.

+ To increase the value. 

YES To confirm the selection.

NO To decline the selection.

SAVE To save an alphanumeric or numeric string.

UP, DOWN, LEFT, 
RIGHT

To move the cursor in the display.

RUNWAY
V :0.00KV
I  :0.00A

HOURS:68
H_TOT :256
EFD: 5.8 Mohm
LFD: - - -

OFF
OFF

STATE:

LOCAL
ESC OPTIONS ALARMS MAINT

A B C D

Name Description

A ESC To return to the Main menu. See § 4.4.

B OPTIONS To go to the Options menu. See § 4.5.

C ALARMS To go to the Alarms menu. See §4.6. 

D MAINT To got to the Maintenance menu. See § 4.7.
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4.5 Options menu
 

Table: 4.4 Buttons

4.6 Alarms menu
 

Table: 4.5 Buttons

For an overview of alarm texts and messages, see § 4.10.

Button Description

RS232/485 To activate or deactivate the RS232 or RS485 port.

MODE To select the correct equipment work mode (see § 9.9):
- NORMAL (for linear loads)
- INDUCTIVE (for non-linear loads (e.g. LED loads))

ID To change the name of the field circuit that the equipment powers. See § 4.9 how to 
enter an alphanumeric string with the HMI. 

SLVNUM To change the address number of the equipment in the RS485 network.

LANG To change the language of the display. 

CONTR To change the display contrast.

LFD To calibrate the LFD.

HCOUNT To reset the HOURS indicator.

Button Description

RESET To reset the alarm: See also § 9.7.

FORWARD To show the previous alarm in the list: See also § 4.10.
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4.7 Maintenance menu
Before you can access the maintenance menu, you must fill in a password.

 

Table: 4.6 General function buttons

4.8 Mode menu
 

Table: 4.7 General function buttons

Button Description

TEST Shows the DSP microcontroller operating parameters. These parameters show the 
state of the software process that controls the equipment. These parameters are 
only for an advanced user.

MORE To go to more submenus: 
- IGBT TEST 

A verification test of the IGBT. 
- INPUT FREQ

Do not change this parameter.
- REMOTE CONTROL MODE

Multiwire or J-Bus
- JBUS PROTOCOL

MCR2 protocol or MCR3 protocol
- CSE/MODE

Activate circuit selector. Yes or No.
- JBUS mode

485 or Ethernet mode
- MULTIWIRE CONFIGURATION

To configure the output pins of the multiwire connector. You can change the 
connector function with the ON and OFF buttons. To save the configuration, push 
the ENTER button.

- V/I CALIBRATION
Do not use this parameter.

- ETHERNET CONFIGURATION
Only for an equipment with the Ethernet Remote Control PCB. To configure the 2 
IP addresses.

Button Description

RAMP TIME The time that the equipment takes to change from one brightness step to another, in 
seconds (0 to 125 s).

HALFWAVE WIDTH To enhance the current peak. You can decrease the half wave width and so reshape 
the sinosoidal waveform (50 to 100%). The default value is 100% (no 
enhancement).

MAX PWM WIDTH To smoothen the maximum current the equipment can supply to prevent a too high 
current to run on the lamps. You can reduce maximum power threshold on the PWM 
cycle (1 to 100%). The default value is 100% (no threshold on the current output).

CURRENT LIMIT Maximum peak current.

PID TYPE Do not change this parameter.
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4.9 How to enter an alphanumeric string
1. The display shows an alphanumerical matrix (B).
2. Push the LEFT and RIGHT buttons to select the character.
3. Push the ENTER button. The HMI adds the character to the 

string (A).
4. Push the CANCEL button to delete the last character.
5. Push the SAVE button to confirm the string.

WIG

A B C D E F H I J K L M
N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9 Space

ESC SAVE LEFT RIGHT

A B
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4.10 Alarm texts and messages on the HMI

There are four types of alarms:
- Equipment alarms

- The equipment automatically switches OFF. Restart the equipment only after you have found the 
cause of the alarm.

- The red light goes on but the equipment still operates. Find the cause of the alarm.
- Field alarms

- The equipment automatically switches OFF. Restart the equipment only after you have found the 
cause of the alarm.

- The red light goes on but the equipment still operates. Find the cause of the alarm.
 

Alarm text / message Possible cause
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450V EFD MISSING The 450 V EFD test voltage is missing. x x

560VDC BUS 
OVERCURRENT

The current on the primary power 
transformer is too high.

x x

ALARM!!! Several alarms have occurred at the same 
time.

x x

BAD REGULATION The current did not reach the selected level 
within the ramp up time.

x x

DSP ERROR OR WRONG 
FIRMWARE

The CPU DSP has failed or the DSP 
firmware is corrupted.

x x

EFD LEVEL 1 FAULT The resistance to earth is less than level 1 
(20 MOhm default value).

x x

EFD LEVEL 2 FAULT The resistance to earth is less than level 2 
(2 MOhm default value).

x x

GATE H FAULT There is a problem with the H-bridge 
(IGBT). On the HMI, a message shows 
“IGBT KO: xxx x”.

x x

IGBT KO: ... Both IGBTs are broken. x x

IGBT KO: BTM A The IGBT A is broken. x x

IGBT KO: TOP A The IGBT A is broken. x x

IGBT KO: BTM B The IGBT B is broken. x x

IGBT KO: TOP B The IGBT B is broken. x x

IGBT KO: TOP BTM A The IGBT A is broken. x x

IGBT KO: TOP BTM B The IGBT B is broken. x x

INPUT VOLTAGE TOO 
HIGH

The input voltage is too high. x x

INPUT VOLTAGE TOO 
LOW

The input voltage is too low. This can lead 
to an over current situation.

x x
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LFD LEVEL 1 FAULT Minimum 3 broken lamps. x x

LFD LEVEL level 2 fault Minimum 5 broken lamps. x x

MAIN CONTACTOR 
FAILED (OFF)

The main contactor is broken. x x

MAIN CONTACTOR 
FAILED (ON)

The main contactor is broken. x x

MAIN DC <95% The rectified 560 V DC voltage is too low. 
(Only applies to 3 phase input).

x x

MAIN REMOTE CTRL 
SWITCH OFF

The main remote control switch does not 
go on when the microprocessor gives an 
‘on’ command.

x x

MAIN REMOTE CTRL 
SWITCH ON

The main remote control switch goes on 
before the microprocessor gives an ‘off’ 
command.

x x

MANY ERRORS HAVE 
HAPPENED, DURING 
CONTROL

Different alarms are generated in the same 
alarm time interval after the equipment 
startup phase.

x x

MANY ERRORS HAVE 
HAPPENED, DURING ON

Different alarms are generated in the same 
alarm time interval during the equipment 
startup phase.

x x

NO FAN One or more fans do not operate correctly. x x

ONE PHASE MISSING One phase is missing. The display shows 
which phase is missing.

x x

OPEN CIRCUIT The output circuit is interrupted. Link the 
cable correctly before you restart the 
equipment.

x x

OVERCURRENT - The output current is more than Imax 
+5% for minimum 4s.

- The output current is more than Imax + 
20% for minimum 0.4 s.

x x

OVERLOAD The load of the equipment is too high. x x

OVERVOLTAGE FROM 
FIELD

The “IGBT OVP” has stopped the 
equipment when it could not find a suitable 
operation mode after several retries.

x x

PHASE ERROR There is a problem with the mains 
frequency detection.

x x

PIC COMMUNICATION 
ERROR

A faulty communication with the 
measurement PCB.

x x

Alarm text / message Possible cause

Eq
ui

pm
en

t 
al

ar
m

Fi
el

d 
al

ar
m

O
nl

y 
re

d 
lig

ht
 

go
es

 o
n

Eq
ui

pm
en

t 
sw

itc
he

s 
of

f 
au

to
m

at
ic

al
ly



A.07.375e - Edition 2.0 41

Description of the HMI

PRE-CHARGE 
CONTACTOR ON

The pre-charge contactor is broken (VIS 
only).

x x

PRE-CHARGE 
CONTACTOR OFF

The pre-charge contactor is broken (VIS 
only).

x x

SCO / DOOR OPENED A front, rear and or field connection panel is 
open.

x x

TEMPERATURE 
SENSOR FAULT

There is a fault in the temperature 
measurement circuit.

x x

TLC ERROR There is an error on the remote control 
PCB.

x x

TOO HIGH 
TEMPERATURE

The temperature of the heat sink is too 
high.

x x

V IN UNSTABLE The input voltage is not stable. x x

VA DROP LEVEL 
EXCEEDED

The output power goes below a preset 
level.

x x

Alarm text / message Possible cause
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5 Description of the configuration software tool

With the configuration software tool, you can:
- Read the state of the equipment (alarms, output current, input current, ...).
- Read the configuration of the equipment.
- Adjust the configuration of the equipment.
- Test the equipment.
- Send writing and reading commands to the equipment.

To update the software version, contact ADB Safegate.

5.1 Description of screens and menus

5.1.1 General

WARNING
When you activate the configuration tool, you transfer all control of the equipment to the 
configuration software tool. In this situation, remote or local control of the equipment is 
not possible.
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C
D
E
F
G

H
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You can adjust the values in the yellow areas (A).
You can not adjust values in the orange areas (B).
White selection boxes: if the box is marked, the item applies (C).

5.1.2 Screens
- CCR Status screen. See § 5.2.
- Output/Mains screen. See § 5.3.
- Test screen. See § 5.4.
- Configuration screen. See § 5.5.
- EFD/LFD screen. See § 5.6.
- Diag/Dsp/BUS screen. See § 5.7.
- Copy Parameters screen. See § 5.8.
- Log screen. See § 5.9.
- Test JBus screen. See § 5.10.

Description

A Slave To select the slave number of the equipment you want to connect to.

B Connection To open and close the port to the selected slave number.

C Rem Reset To reset the alarm. See also § 9.7.

D Restore 
configuration

To restore a saved configuration from the PC to the equipment.

E Save 
configuration

To make the values sent to the equipment active on eeprom.
The values you send to the equipment are not active on the eeprom.

F Default 
configuration

To return to the factory default configuration.

G Message bar Shows communication messages and error messages about the software 
configuration tool.

H Exit To exit the configuration software tool.

A

B

C
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5.2 CCR status screen

 

K L

A B FC D E G H I J

Description

A Active step Shows the active brightness step of the selected equipment.

B Burnt lamps Shows the number of burnt lamps in the series circuit.

C CCR Status See § 5.2.1.

D EFD Errors See § 5.2.2.

E Bus Error Only applies to a double J-Bus or Ethernet connection.

F LFD Errors See § 5.2.3.

G Regulation 
Errors

See § 5.2.4.

H CCR Errors See § 5.2.5.

I Mains Voltage 
Errors

See § 5.2.6.

J Output See § 5.2.7.

K Start To show the parameters of the selected slave equipment.

L Stop To stop to show the parameters of the slave equipment.



46 A.07.375e - Edition 2.0

Description of the configuration software tool

5.2.1 CCR Status
 

5.2.2 EFD Errors
 

5.2.3 LFD Errors
 

Item Description

Event An error event occurred.

DB Chgd A change was made to the database.

DB Valid The data in the database is up to date.

CCR Master LOCAL SELECTOR: the master is in LOCAL mode
PC: the RS232 port of the master is active.
BUS A. The J-BUS is active and the master is in REMOTE mode.

Possible cause Alarm type

Level 1 exceeded The resistance to earth is less than 
level 1 (20 MOhm default value).

The red light on the equipment 
goes on.

Level 2 exceeded The resistance to earth is less than 
level 2 (2 MOhm default value).

450V supply out of range The 450 V EFD test voltage is 
missing.

Scale Shows 0 for a 20 µA EFD scale and 1 for a 200 µA EFD scale.

Isolation resistance Shows the isolation resistance value (0 to 500 MOhm).

Possible cause Alarm type

Level 1 of Burnt Lamps is 
exceeded

Minimum 3 broken lamps. The red light on the equipment 
goes on.

Level 2 of Burnt Lamps is 
exceeded

Minimum 5 broken lamps.

Level 1 VA-Drop is exceeded The output power goes below a 
preset level.

Level 2 VA-Drop is exceeded The output power goes below a 
preset level.

Error in LFD Reference Calibration The LFD reference calibration is not 
done or is not successful.

Error in LFD Removed Lamps 
Calibration

The LFD removed lamps calibration is 
not done or is not successful.
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5.2.4 Regulation Errors
 

Possible cause Alarm type

CCR switched OFF for 
OVERCURRENT

- The output current is more than 
Imax +5% for minimum 4s.

- The output current is more than 
Imax + 20% for minimum 0.4s.

- The equipment 
automatically switches OFF.

- Restart the equipment only 
after you have found the 
cause of the alarm.CCR switched OFF for OPEN 

CIRCUIT
The output circuit is interrupted. 
Connect the cable correctly before 
you restart the equipment.

Measure board connector 
disconnected

There is no communication between 
the CPU PCB and the measure PCB. 

Possible root causes:
- The optical cable is disconnected.
- The power supply cable is 

disconnected.
- Malfunction of the measure PCB.

CCR is in OVERLOAD The load of the equipment is too high.

Output current is unstable The output current fluctuates or could 
not reach the requested value.

Possible root causes:
- Load switching (E.g. Aglas, Brite).
- To much load on the series circuit.
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5.2.5 CCR Errors
 

Possible cause Alarm type

DC BUS Voltage too low Only for a three-phase equipment. 
The voltage on the DC bus does not 
reach the nominal value.

Possible root causes:
- Malfunction of the IGBT.
- The wiring is not connected 

properly.

- The equipment 
automatically switches OFF.

- Restart the equipment only 
after you have found the 
cause of the alarm.

Temperature Fault The temperature of the heat sink is 
too high.

SCO/Door opened A front, rear and/or field connection 
panel is open.

The red light on the equipment 
goes on.

Main Contactor Fault The main contactor does not switch 
on when the microprocessor gives an 
‘on’ command.

Possible root causes:
- Malfunction of the main contactor.
- Malfunction of the feedback of the 

contactor.
- A faulty connection on the power 

supply PCB.

Pre-Charge Contactor Fault The precharge contactor does not go 
on when the microprocessor gives an 
‘on’ command.

Possible root causes:
- Malfunction of the main contactor.
- Malfunction of the feedback of the 

contactor.
- A faulty connection on the power 

supply PCB.

Temperature Sensor Fault There is fault in the temperature 
measurement circuit.

- The equipment 
automatically switches OFF.

- Restart the equipment only 
after you have found the 
cause of the alarm.

Blower Fault One or more fans do not operate 
correctly.

I Primary Fault There is a problem with the current 
after the IGBT.

IGBT Fault The IGBT test did not succeed after 
the ‘ON step request’.

Possible root causes:
- Malfunction of the IGBT.
- A faulty wiring between the CPU 

PCB and the IGBT PCB.
- Malfunction of the IGBT PCB.
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5.2.6 Mains Voltage Errors
 

5.2.7 Output
 

Possible cause Alarm type

Mains Voltage too Low The input voltage is too low. This can 
lead to an over current situation.

- The equipment 
automatically switches OFF.

- Restart the equipment only 
after you have found the 
cause of the alarm.

Mains Voltage too high The input voltage is too high.

Mains Voltage unstable The input voltage is not stable. The red light on the equipment 
goes on.

Item Description

I_out Shows the output current.

V_out Shows the output voltage.

P_out Shows the output power.

V_in Shows the input voltage.

Pwm Shows the PWM.
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5.3 Output/Mains screen

 

 

A B C D E F G H I

Description

A Output screen 
part

See items B to F.

B Output currents See § 5.3.1.

C Imax Shows the maximum output current.

D Overcurrent See § 5.3.3.

E Off if overload See § 5.3.2.

F Step 
parameters

See § 5.3.4.

G Read To read the actual Output parameters from the selected equipment.

H Mains See § 5.3.5.

I SHVS Not used
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5.3.1 Output currents
 

Example:
When you select 4 brightness steps and you select 4.750 A for brightness step 4, brightness steps 5 to 8 are 
disabled and get 4.750 A current assigned automatically.

5.3.2 Off if overload
 

5.3.3 Overcurrent
 

5.3.4 Step Parameters
 

Item Description

Number of Steps To select the number of brightness steps.

Brightness 1 to 8 To adjust the current for each brightness step, accurate up to 25 mA.

Change To activate the values and to send them to the equipment.

Note
When you select less than 8 brightness steps, the steps higher than the highest step 
automatically get the current of the highest brightness step.

Item Description

CCR Remains ON To make sure that the equipment remains ON when the equipment is in overload 
state and the alarm comes up.

CCR Switches OFF To make sure that the equipment switches OFF when the equipment is in overload 
state and the alarm comes on.

Change To activate the values and to send them to the equipment.

Item Description

Level 1 and Level 2 To set the percentage of the maximum of the two thresholds for overcurrent. The 
screen part also shows the actual current threshold values.

Delay 1 and 2 To set the delay before the overcurrent alarm comes on, in s.

Change To activate the values and to send them to the equipment.

Item Description

Step_Speed To set the time that the equipment takes to change from one brightness step to 
another, in seconds (0 to 125 s).

Inter_Br To define an intermediate brightness between steps.

Change To activate the values and to send them to the equipment.
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5.3.5 Mains
 

Item Description

V_in_Scale Shows the scale used to calculate the nominal voltage.

V_in_Nom Shows the nominal supply voltage.

V_in_High To adjust the supply voltage threshold above which the equipment restarts when it 
switched OFF due to a too low supply voltage.

V_in_Low To adjust the supply voltage threshold below which the equipment gives an alarms 
and switches OFF.

V_in_Warn To adjust the voltage threshold above which the equipment gives an alarm.

Frequency_In Shows the supply voltage frequency.

Change To activate the values and to send them to the equipment.

Read To read the actual Mains parameters from the selected equipment.
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5.4 Test screen

 

5.4.1 Brightness
 

Description

A Read To read the actual Analogue Data parameters (AD0 to AD7) from the selected 
equipment.

B Brightness See § 5.4.1.

C Ctrl Hardware 
Iprim

See § 5.4.2.

D Switch on 
JBUS

To enable the J-Bus serial port an to disable the RS232 serial port.

E Test 
Overcurrent

To start the overcurrent alarm test.

F Test JBUS See § 5.4.3.

A B C D E F

Item Description

Brightness To select the step.

Standby To set the selected equipment to stand-by.

Change To activate the values and to send them to the equipment.
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5.4.2 Ctrl Hardware Iprim
 

5.4.3 Test JBUS
 

Item Description

I primary hardware 
protection

Shows if the primary current hardware protection is released. This is a read-only 
parameter.

Reset To reset the primary current hardware protection.

Read To read the actual primary current protection parameter from the selected 
equipment.

Item Description

N. To select the data line.

Value To select the test data value.

Read To read the actual JBUS parameters from the selected data line.

Write To send the selected test data to the selected data line.
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5.5 Configuration screen

 

A B C D E F G H I J K

Description

A CCR ID See § 5.5.1.

B Change Slave 
Number

See § 5.5.2.

C Firmware 
version

Shows the firmware version of the selected equipment. 

D Firmware 
details

Shows a description on the firmware version of the selected equipment.

E SN/YearCode See § 5.5.3.

F Setup Save 
Date

Shows the date and time of the latest save of the data of the selected equipment. 
The date and time are generated from the PC that is connected to the equipment.

G Maintenance 
Password

See § 5.5.4.

H Read To read the actual configuration parameters from the selected data line.

I Open Circuit Do not use these parameters. There is a risk of damage to the equipment. Only ADB 
Safegate service engineers are allowed to use these parameters.J Regulation 

Rate

K Regulation 
Parameters
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5.5.1 CCR ID
 

5.5.2 Change Slave Number
 

5.5.3 SN/YearCode
 

5.5.4 Maintenance Password
 

Item Description

Blank field To change the name of the field circuit that the equipment delivers power to. This 
name shows in the HMI.

Change To activate the value and to send it to the equipment.

Item Description

Slave Number To adjust the slave number of the selected equipment.

Change To activate the value and to send it to the equipment.

Item Description

YearCode/SN To change the production year and the serial number.

Change To activate the value and to send it to the equipment.

Item Description

Old Password Shows the current maintenance password.

New Password To adjust the maintenance password.

Confirm Password Copy the adjusted maintenance password for confirmation.

Change To activate the value and to send it to the equipment.
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5.6 EFD/LFD screen

 

A E F G H I JB C D

Description

A EFD Enable See § 5.6.1.

B EFD Levels See § 5.6.2.

C Reset error To reset the EFD error. 

D Read To read the actual EFD parameters from the selected equipment.

E LFD Calibrated Shows if the LFD is calibrated.

F LFD not 
Calibrated

Shows if the LFD is not calibrated.

G LFD Inh See § 5.6.3.

H LFD Levels See § 5.6.4.

I VA Drop + 
delay

See § 5.6.5.

J Read To read the actual LFD and VA Drop parameters from the selected equipment.
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5.6.1 EFD Enable
 

5.6.2 EFD Levels
 

5.6.3 LFD Inh
 

5.6.4 LFD Levels
 

Item Description

State To select if the EFD measurement is enabled or disabled.

Measure If the EFD measurement is enabled, you can choose between these values:
- Interval: the interval between measurements is indicated in the Min-Sec field.
- Continuous: the equipment measure continuously. The Min-Sec field is not 

active.

Min-Sec To set the time between measurement if the measurement is set as interval.

Change To activate the value and to send it to the equipment.

Item Description

EFD Range Shows the maximum earth leakage value the equipment can measure.

EFD Level1 To adjust the insulation resistance below which the equipment gives the EFD Level 
1 alarm.

EFD Level2 To adjust the insulation resistance below which the equipment gives the EFD Level 
2 alarm.

Change To activate the value and to send it to the equipment.

Item Description

State To select if the LFD is enabled or not.

Mode To choose between different LFD modes:
- Normal: both the LFD 1 and 2 Levels are active.
- Degraded: only LFD 2 Level is active.

Change To activate the value and to send it to the equipment.

Item Description

LFD Level1 and 
Level2

To adjust the threshold above which the equipment gives the LFD Level 1 and 
Level 2 alarm.

Change To activate the value and to send it to the equipment.
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5.6.5 VA Drop + delay
 

5.7 Diag/Dsp/BUS screen

 

Item Description

VA Drop1 and Drop2 To adjust the threshold above which the equipment gives the VA Drop 1 and Drop 2 
alarm.

LFD Delay To adjust the minimum time span after the error before the equipment gives the 
LFD Level 1 or Level 2 alarm.

VA Drop Delay To adjust the minimum time span after the error before the equipment gives the VA 
Drop 1 or Drop 2 alarm.

Change To activate the value and to send it to the equipment.

A B G HC D E F

Description

A Slave errors See § 5.7.1.

B Rem Reset See § 5.7.2.

C Dsp 
parameters

See § 5.7.3.
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5.7.1 Slave Errors
 

D Imp Test See § 5.7.4.

E Hours_Meter See § 5.7.5.

F Bus 
Parameters

- Arbiter: To set the signal source for remote control. To set a priority for different 
systems. If you set this parameter to disabled, remote control is not possible.

- BF Mode: Use normal or stop bar.
- BF Time: The time after which the equipment starts to use the default settings.
- BF Def: To set default values that the equipment uses when the remote control 

(J-Bus) connection is down for longer than the time set in the menu. Leave this 
field blank or set a value from 1 to 8.

- Select either Stay on Prevent step or Go to Bf-Def.

G Speed See § 5.7.7.

H Read To read the actual J-Bus parameter of the equipments.

Note
To show the screen part with the bus parameters, select Options>Advanced.

Description

Item Description

Read buttons To read the actual slave error from the selected equipment.

Tot_Mess Shows the number of messages that the equipment received.

Crc_Err Shows the number of messages with checksum that the equipment received.

Exception Shows the number of messages with wrong commands that the equipment 
received.

Own_Mess Shows the number of messages that belong to the selected equipment.

No_Ack Shows the number of messages for which the equipment did not receive a reply.

Overrun Shows the number of messages with overrun that the equipment received.

Silent Shows the if the equipment replies to messages:
- 0: the equipment replies to messages.
- 1: the equipment goes not reply to messages.

Test field To test the communication. You can enter a number in the field to test.

Test button To test the communication with the value in the test field.

Restart 
Communic.Opt

To set all counters to 0 and the silent value to 0.

Force Listen Only 
Mode

To set the silent field to 1 and to force the equipment to reply to messages.

Clear Counters To set all counters to 0 but not to change the silent value.
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5.7.2 Rem Reset
 

5.7.3 Dsp Parameters
 

5.7.4 Imp Test
 

5.7.5 Hours_Meter
 

Item Description

Rem Reset To enable or disable the Rem Reset button.
- 1: the Rem Reset button is enabled.
- 0: the Rem Reset button is disabled.

Change To activate the value and to send it to the equipment.

Read To read the actual Rem Reset parameter from the selected equipment.

Item Description

Dsp_Sel To select what the HMI shows optionally. You can choose from four parameters. 
The HMI only shows the selected parameter.
- LAMP: the number of broken lamps.
- VA_Out: the VA output.
- VA_Out%: the percentage of the VA output.
- LMP_Test: to carry out a display test.

Desp_Sel_Def To select what the HMI shows optionally. You can choose from four parameters. 
The HMI shows the selected parameter, but only for the time indicated in the 
DSP_Hold field.
- LAMP: the number of broken lamps.
- VA_Out: the VA output.
- VA_Out%: the percentage of the VA output.
- LMP_Test: to carry out a display test.

Dsp_Hold To adjust the time the HMI shows the optional parameter.

Dec_Separ To adjust the decimal separator for the UI (, or .).

Change To activate the value and to send it to the equipment.

Item Description

Leds To carry out a test on the LEDs of the keyboard on the HMI. The LED adjacent to 
the DB9 connector comes on.

Change To activate the value and to send it to the equipment.

Item Description

Total Shows the total time that the equipment is set to ‘on’ in h.

Max Br. Shows the time that the equipment operates at the maximum brightness step in h.

Read To read the actual hours parameters from the selected equipment.
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5.7.6 Rem Reset Circuit selector
 

5.7.7 Speed
 

5.8 Copy Parameters screen

 

Item Description

Circuit selector When the boxed is checked, the circuit selector will be reset.

Change To activate the value and to send it to the equipment.

Read To read the actual Circuit selector parameter from the selected equipment.

Item Description

BaudRate To adjust BaudRate of the J-Bus connection between the equipments.

Parity To adjust the parity of the J-Bus connection between the equipments.

Change To activate the value and to send it to the equipment. Do not change the speed 
parameters when you connect the equipment with the ethernet line.

 

A B

Description

A Load 
parameters 
from ccr

See § 5.8.1.

B Save To save the parameters from the PC to the selected equipment.
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5.8.1 Load parameters from ccr
 

5.9 Log screen

 

Item Description

Hours meter To select if you want to load/save the hours meter values of the equipment.

Lfd calibration To select if you want to load/save the LFD calibration parameters of the equipment.

all parameters To select if you want to load/save the all parameters of the equipment.

Load To load the selected parameters to the PC.

Description

A Dowload To show the history file of the selected equipment in the Log screen.

B Save Log To save the log file to the PC.

 

A B
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5.10 Test JBus screen

 

Description

A Start Test To start the test.

B Stop To stop the test.

C No. of slaves Shows the number of slaves.

D Reg. start

E No. of reg

A B C D E
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6 Install and operate the configuration software tool

6.1 Install the configuration tool software

Requirements
System requirements:
- PC with Microsoft Windows 2000, XP operation system, or later;
- At least 50 Mbytes free disk space;
- 1 free serial communication (COM) port, or a virtual serial communication port over a USB bridge or a 

PCMCIA card;
- PC user account with either administrator or power user rights.

1. Move the WINCCR.exe file from the CD-ROM to the harddrive of the PC.

6.2 Start the configuration software tool
Activate the serial port, if applicable
1. On the HMI, push the MENU button to go to the Main menu.
2. Push the SER/JBUS button to go to the SER/JBUS screen.
3. Push the SERIAL button to activate the serial port.

Configure the ethernet port, if applicable
1. On the HMI, push the MENU button to go to the Main menu.
2. Push the MORE button to go to the Mode screen.
3. Push the ETHERNET CONFIGURATION button to configure the ethernet port.

Find the slave number of the equipment
1. On the HMI, push the ESC button to go to the Main menu.
2. Push the OPTIONS button to go to the Options menu.
3. Push the SLVNUM button to show the slave number.
4. Take a note of the slave number. You will need it for reference later.

Connect the serial cable, if applicable
1. Switch OFF the equipment. See § 9.2.
2. Connect the extension cable to the dongle (A) and to the 

serial communication port of the PC (B).
A B
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Connect ethernet cable, if applicable
1. Switch OFF the equipment. See § 9.2.
2. Connect the ethernet cable (B) to the equipment (A) and to 

the PC (C).

Configure the remote control ethernet connection
1. Make sure that the IP range of the PC is in the same range as the device.
2. Access the web control interface of the device.
3. From the Network Settings control panel, set the IP address, Netmask, and IP configuration to the 

values of the network that the Ethernet board uses.
4. From the Serial Settings control panel, make sure that the serial parameters have the values that follow:

- Baud Rate: 9600
- Data Bits: 8
- Stop Bits: 1
- Parity: None

5. From the Operating Settings control panel, make sure that the Port=01 parameters have the values that 
follow:
- Operation mode: TCP Server Mode
- TCP alive check time: 0
- Inactivity time: 5000
- Max connection: 1

6. Make sure the Data Packing parameters have the values that follow:
- Delimiter 1: 0. Do not select Enable. 
- Delimiter 2: 0. Do not select Enable. 
- Force transmit: 10

7. Make sure the TCP Server Mode parameters have the values that follow:
- Local TCP port: 502
- Do not select Apply the above settings to all serial ports.

8. From the Serial Command Mode control panel, make sure the serial parameters have the values that 
follow:
- Trigger Setting: HW Trigger
- SW Trigger Character: 2B 2B 2B

Start software
1. Switch the equipment ON.
2. Click the WINCCR.exe file in the directory where you installed the software. The configuration tool opens 

on the CCR Status screen.

A B C
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Setup the serial port, if applicable
1. Select the menu Communication.
2. Select the applicable serial communication port (COM).

3. Push the OK button to confirm the settings.
4. Push the Open Port button to open the selected serial port.

- If the settings are correct, the yellow OK button is enabled and the message bar shows the message 
‘Port opened’.

- If the settings are not correct, the bottom bar shows an error message.

Setup the ethernet port, if applicable
1. Select the menu Communication>Ethernet.
2. Select the applicable IP address and Port.
3. Push the OK button to confirm the settings.
4. Push the Open Port button to open the selected serial port.

- If the settings are correct, the yellow OK button is enabled and the bottom bar shows the message 
‘Port opened’.

- If the settings are not correct, the bottom bar shows an error message.

6.3 Monitor the data of an equipment
Select the equipment
1. Select the slave number of the equipment you want to monitor.
2. Push the OK button.

Start to monitor
1. Select the CCR status screen. See § 5.2.
2. Push the Start button. The screen shows the data of the selected equipment.

Stop to monitor
1. Push the Stop button. The screen does no longer how the data of the selected equipment.

6.4 Stop the configuration software tool
1. Serial connection: Disconnect the extension cable from the dongle and the PC connector of the 

equipment.
2. Ethernet connection: Disconnect the ethernet cable from the PC and the equipment. 

Note
The baud rate and parity settings for the communication between the PC and the 
equipment must be the same. For the dongle, the default baud rate is 9600 and the 
default parity setting is None. 



68 A.07.375e - Edition 2.0

Install and operate the configuration software tool



A.07.375e - Edition 2.0 69

Commissioning

7 Commissioning

7.1 Main commissioning procedure
1. Do the first start-up. See § 7.2.
2. Calibrate the Lamp Fault Detection (LFD) module. See § 7.3.
3. Adjust the number of available brightness steps. See § 8.6.
4. Configure the remote control interface (option). See § 7.4, § 7.5 and/or § 7.4 dependent upon the 

hardware.

7.2 First start-up
The equipment stores the last request after a power cycle. This means that when the equipment is switched 
ON, it starts to produce the same output current that was valid before the equipment was switched OFF.

When you start up the equipment for the first time, the powering-down status is unknown. This procedure 
allows to prevent the equipment to produce output current at the first start-up.

7.2.1 Procedure
1. Measure the input voltage. See § 7.2.2.
2. Measure the output current in short circuit. See § 7.2.3.
3. Measure the resistance and the insulation resistance of the series circuit. See § 7.2.7.
4. Measure the output current to the series circuit. See § 7.2.15.

7.2.2 Measure the input voltage
Prepare
1. Make sure that the manual switch is in the OFF position.  See § 8.3.
2. Remove the lower rear panel. See § 10.3.
3. Set the manual switch to the ON position. 
4. On the UI, push the Local button. The screen now shows the state LOCAL.
5. Push the OFF button. The equipment goes to the mode OFF.

Measure
1. Measure the input voltage on the input terminals (A). Use a 

True RMS Multimeter. 
2. Examine if the voltage is in accordance with:

- The nameplate of the equipment.
- Local regulations.

Finish
1. Switch off the power supply. See § 8.3.
2. Install the lower rear panel.

CAUTION
An excessive input 
voltage can damage the 
equipment.

A
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7.2.3 Measure output current in short-circuit
1. Make sure that all power to the equipment is OFF. See § 9.3.
2. Put the output in short-circuit. For SCB, see § 7.2.4. For SCO, see § 7.2.5. 
3. Measure the output current in short-circuit. See § 7.2.3.
4. Make sure that all power to the equipment is OFF. See § 9.3.
5. If you use an SCB: Remove the separate piece of cable and connect the series circuit cables. See 

§ 7.2.4. 
6. If you use an SCO: set the SCO to mode A. See § 9.8.

7.2.4 Put SCB in short-circuit

Strip cables
1. Strip a separate piece of series circuit cable at both ends.

- A: unscreened cables
- X: 16 mm
- ∅ Y: less than or equal to 18 mm

- B: screened cables
- X: 16 mm
- ∅ Y: less than or equal to 18 mm
- U: 11 mm
- Z: 77 mm

Remove the box panel of the SCB
1. Loosen the screws (A).
2. Remove the box panel (B).

Short circuit SCB with separate piece of output cable
1. Disconnect the series circuit cables.
2. With the separate piece of output cable (B), short-circuit the 

output terminals (A).
3. Install the box panel.

X Z
U

X

Y

A B

Y

A

A

B

B

A
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7.2.5 Put SCO in short circuit
1. Set the SCO to mode C. See § 9.8.

7.2.6 Measure the output current in short circuit

Connect AC True RMS multimeter (SCB)
1. Connect the current clamp of an AC True RMS multimeter (B) 

to the short-circuited cable (A).

Connect AC True RMS multimeter (SCO)
1. Connect the current clamp of an AC True RMS multimeter (B) 

to the output cable (A).

Measure output current
1. Switch ON the equipment and set it to LOCAL mode. See § 9.1.
2. Select the step 6.6 A.
3. Read the output current value from the AC True RMS Multimeter.
4. Repeat the previous steps and examine the output current value for each brightness step. Check each 

brightness step separately from the highest to the lowest level.

7.2.7 Measure resistance and the insulation resistance of series circuit
1. Prepare the series circuit. For SCB, see § 7.2.8. For SCO, see § 7.2.9.
2. Measure the resistance of the series circuit. See § 7.2.10.
3. Measure the insulation resistance of the series circuit. See § 7.2.11.
4. Calculate minimum insulation resistance of series circuit. See § 7.2.12.
5. Calculate resistance of series circuit See § 7.2.13.
6. Complete the activities. See § 7.2.14.

7.2.8 Prepare with SCB

Set power to OFF
1. Make sure that all power to the equipment is OFF. See § 9.3.

A
B

A
B
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Remove the box panel
1. Loosen the screws (A).
2. Remove the box panel (B).

Discharge the output terminals
1. Discharge the output terminals.
2. Completely remove the series circuit cables, also the shielding, if applicable.

7.2.9 Prepare with SCO

Set power to OFF
1. Make sure that all power to the equipment is OFF. See § 9.3.
2. Set the SCO to mode C. See § 9.8. The output terminals are now discharged.

Remove cover
1. Open the lock (A).
2. Remove the cover (B). Use the handle.

Remove series circuit cables
1. Completely remove the series circuit cables, also the shielding, if applicable.

A

A

B

B

A
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7.2.10 Measure resistance of series circuit
1. Measure the resistance: measure on the ends of the series 

cable (A). Use a multimeter (B), in accordance with local 
regulations.

7.2.11 Measure insulation resistance of series circuit
1. Join the ends of the series circuit cables (C).
2. Measure the insulation resistance of the series circuit. Use 

the insulation tester (E). Megger 5000 V or 10000 V, in 
accordance with local regulations.
- A: when the series circuit cable is not shielded
- B: when the series circuit cable is shielded. Measure the 

earth on the shield (D).

7.2.12Calculate minimum insulation resistance of series circuit
 

Table: 7.1 Theoretical insulation resistance for the series circuit

Example: a runway centre-line circuit with 133 light fixtures with a total length of the series circuit of 8 km.
- Allowed insulation resistance current for the transformers is 133 x 2 = 266 µA
- Allowed insulation resistance current the cable is 80 x 1 = 80 µA
- Total allowed insulation resistance current for this circuit is 266 µA + 80 µA = 346 µA
- When you test with 5000 V, according to Ohms law, the minimum resistance is 14 MOhm.

B A

B

A

D

C

C

E

E

Item Maximum insulation resistance current (standard: ICAO, 
part 5, § 3.9.4.7) [µA]

Series transformer 2

100 m of cable with standard number of 
connectors

1
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7.2.13Calculate resistance of series circuit
Rprim = ρ x L/A + y x 0.1212

Where:
Rprim = resistance of the series circuit in Ohm
ρ = 18 x 10-3 (Ohm x mm2)/m 
L = length of the circuit in m
A = section of the cable in mm2

y = number of series transformers in the circuit

Example:
circuit length is 8000 m
cable section is 6 mm2

number of series transformers is 122
Then Rprim = (18 x 10-3) x 8000/6 + 122 x 0.1212 = 36.7 Ohm

7.2.14 Complete the measurement
1. Make sure that the measured and the calculated values match and that all the values are in accordance 

with all local safety regulations.
2. Connect the series circuit cables to the equipment.
3. Install the cover or the box panel.

7.2.15 Measure the output current to the series circuit

Prepare
1. Make sure that the series circuit is measured and approved. 

See § 7.2.7.
2. Make sure that all power to the equipment is OFF. See § 9.3.
3. Make sure that the series circuit is connected.
4. Connect an AC current clamp (B) to the series circuit 

cable (A).

Measure
1. Switch ON the equipment and set it to LOCAL mode. See § 9.1.
2. Select the step 6.6 A.
3. If the output current does not reach 6.6 A, change the series circuit configuration before you proceed. 

This indicates that the equipment is too small for the load.
4. Compare the output current reading on the HMI with the reading on the True RMS Multimeter.
5. Examine if the output current readings are in accordance with local regulations.
6. If not, do not continue.

Check brilliancy level
1. Examine if all light fittings have the same brilliancy level. Go to the runway area to make a visual 

inspection. 
2. Examine all the brightness steps separately. Go through the whole procedure for each brightness step.

Finish
1. Wait for approximately 30 minutes and make sure that he equipment works correctly.
2. Make sure that all power to the equipment is OFF. See § 9.3.

A
B
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7.3 Calibrate Lamp Fault Detection (LFD) 

Do this procedure to make sure that the equipment indicates the correct number of broken lamps. 
See § 3.5.12 for the accuracy of the LFD.

Make sure that all lamps in the series circuit operate
1. Make sure that the equipment is connected to the series circuit.
2. Switch ON the equipment and set it to LOCAL mode. See § 9.1. 
3. Set the equipment to the highest brightness step. See § 9.5.
4. Examine if all light fittings light up. Go to the runway area to make a visual inspection. 
5. Push the OFF button on the UI.

Select LFD calibration
1. On the HMI, push the OPTIONS button to go to the Options menu.
2. Push the LFD button. The HMI asks if you want to do the calibration.
3. Push the Yes button. The HMI asks the number of burnt lamps (0 - 99).
4. Select ‘0’, no broken lamps.
5. Wait until the equipment shows the Main screen. See § 4.3.

Remove lamps
1. Make sure that all power to the equipment is OFF. See § 9.3.
2. Earth the series circuit.

- With the SCO. See § 9.8.
- With an earthing wire on the SCB.

3. Remove a number of lamps in the field.

4. Switch ON the equipment and set it to LOCAL mode. See § 9.1.

Set number of removed lamps
1. On the HMI, push the OPTIONS button to go to the Options menu.
2. Push the LFD button. The HMI asks if you want to do the calibration.
3. Push the Yes button. The HMI asks the number of burn lamps (0 - 99).
4. Enter the number of removed lamps.
5. Wait until the equipment shows the Main screen. See § 4.3.

Examine the LFD measurement
1. Make sure that all power to the equipment is OFF. See § 9.3.
2. Connect a number of lamps, but not all. 
3. Switch ON the equipment and set it to LOCAL mode. See § 9.1.
4. Make sure that the number of lamps removed corresponds to the LFD reading on the main menu.
5. Make sure that all power to the equipment is OFF. See § 9.3.
6. Leave the equipment OFF for 10 seconds.
7. Repeat the previous steps and connect the rest of the lamps.

CAUTION
The LFD module does not work if the series circuit includes these types of lights:
- LED lights without the monitoring option;
- PVO/PVL lights (guidance signs);
- WIGWAG (runway guard lights).

Note
Choose the number of lamps in function of the alarm level you 
use. By default, 8 to 10 lamps.
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Set alarm level
1. With the configuration software tool, set the LFD Level1 and LFD Level2 alarm levels. See § 5.6.

7.4 Remote control configuration: multiwire (option)
Examine if the equipment is set to multiwire remote control
1. On the HMI, push the MENU button to go to the Main menu.
2. Push the MAINT button to go to the Maintenance menu. See § 4.8.
3. Push the MORE button.
4. Push the → or ← buttons until the HMI shows the remote control mode.
5. Make sure that the remote control mode is ‘MULTIWIRE’.
6. If necessary, adjust the remote control mode.

Examine or adjust the input and output signals function assigned to terminals
1. Push the → or ← buttons until the HMI shows the multiwire configuration.
2. Check and adjust the signals if necessary. See § 4.8.

7.5 Remote control configuration: J-Bus (option)
Configure the slave number
1. On the HMI, push the MENU button to go to the Main menu.
2. Push the OPTIONS button to go to the Options menu.
3. Push the SLVNUM button to set the slave number of the equipment.
4. Push the SAVE button to save the slave number to the equipment.

Examine and adjust the configuration, if necessary
1. On the HMI, push the ESC button a number of times until the UI shows the Main menu.
2. Push the MAINT button to go to the Maintenance menu. See § 4.7.
3. Push the MORE button.
4. Push the → or ← buttons until the HMI shows the remote control mode.
5. Set the remote control mode to ‘JBUS’.
6. Set the applicable J-Bus protocol. The default value is ‘MCR2’.
7. Set the J-Bus mode to ‘485’.

7.6 Remote control configuration: ethernet (option)
Examine the remote control mode and adjust if necessary
1. On the HMI, push the MENU button to show the Main menu. See § 4.4.
2. Push the MAINT button to go to the Maintenance menu. See § 4.7.
3. Push the MORE button.
4. Push the → or ← buttons until the HMI shows the remote control mode.
5. Set the remote control mode to ‘JBUS’.
6. Set the applicable J-Bus protocol. The default value is ‘MCR2’.
7. Set the J-Bus mode to ‘Ethernet’.

Examine the ethernet configuration and adjust if necessary
1. Push the → or ← buttons until the HMI shows the ethernet configuration.
2. Examine the parameters and adjust if necessary.
3. If you use a double ethernet connection, push the DOWN button until the HMI shows the ethernet 

configuration of the second ethernet connection. 
4. Examine the parameters and adjust if necessary.

Note
For the standard multiwire configuration, see § 12.3. You can only adjust the signals 6 to 
15. The other signals are fixed.
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8 Operation

8.1 Switch ON the equipment
When you switch ON the equipment, it starts to produce the same output current that was valid before the 
equipment was switched OFF.
To set a different output current, select another brightness step. See § 8.5. For more information on the 
produced output currents, see § 12.6.
Prerequisite of this procedure is that the equipment is switched off.
1. Set the manual switch (A) to the ON position.

- The equipment starts to produce the same output current 
that was valid before the equipment was switched OFF.

- The HMI lights up.
- The equipment starts in the same mode as it was stopped: 

Local or Remote mode.

2. If the UI shows that the equipment is in the state OFF, push 
the ON button. The HMI shows the state ON.

3. To switch between Local and Remote mode, see § 8.4.

8.2 Switch OFF the equipment
1. On the HMI, push the Local button. The screen now shows the state LOCAL.
2. Push the OFF button. The equipment goes to the mode OFF.
3. Switch OFF the power supply. See § 8.3.

8.3 Switch OFF the power supply
1. Set the manual switch (A) to the OFF position.
2. Open the main switch on the main distribution board.
3. Disconnect the equipment from the series circuit.

WARNING
High voltage can be 
present on the system.

A

A
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8.4 Switch between local and remote mode

To control the equipment through the HMI switch to the local mode. To control the equipment with the remote 
control system, switch to the remote mode.
1. For Local mode, push the LOCAL button on the HMI. The HMI now shows the mode LOCAL.

2. For Remote mode, push the REMOTE button on the HMI. The UI now shows the mode REMOTE. You 
can now change the brightness step with the remote control device.

8.5 Select brightness step
1. Make sure that the equipment is powered ON, in the ON state and in Local mode. See § 8.1.
2. To select a brightness step, push the corresponding number on the keypad. The equipment immediately 

starts to produce the chosen brightness.

8.6 Adjust number of used brightness steps
1. Use the configuration software tool. See § 5.3. For information on the used brightness steps, see § 13.6. 
2. Examine all brightness steps one by one. See § 8.5. Examine if all light fittings have the same brilliancy 

level. Go to the runway area to make a visual inspection. 

8.7 Alarms
The HMI only shows information about errors that the equipment can detect. The equipment does not detect 
all possible errors. You have to observe if the equipment operates correctly.

LOCAL mode: an alarm occurs, the equipment switches OFF automatically
- If you need to switch off the power supply to remove the cause of the alarm: The equipment starts to 

produce the same output current that was valid before the equipment was switched OFF. 
- If you do not need to switch off the power supply to remove the cause of the alarm: The equipment 

remains in the state OFF. Only after you reset the alarm and push the ON button, the equipment starts to 
produce the same output current that was valid before the equipment was switched OFF. 

REMOTE mode: an alarm occurs, the equipment switches OFF automatically
- If you need to switch off the power supply to remove the cause of the alarm: The equipment starts at the 

actual multiwire/J-Bus command. 
- If you do not need to switch off the power supply to remove the cause of the alarm: After you reset the 

alarm, the equipment automatically goes to the actual multiwire command. 

Reset an alarm
1. If the HMI does not show the alarm, push the Menu button to go to the Main Menu.
2. Push the ALARMS button to go to the Alarms menu.
3. Push the RESET button to reset the alarm.

Clear the error list
1. On the HMI, push the Menu button to go to the Main Menu.
2. Push the ALARMS button to go to the Alarms menu.
3. Push the CLEAR ALARMS button. The equipment clears the error list.

Note
The keypad keys on the HMI only operate when the equipment is in Local mode.
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8.8 Use Series CutOut (SCO)

8.8.1 Operation mode

The SCO has three operation modes:

 

WARNING
Always wear protective gloves and shoes when working with the equipment or series 
circuit.

Description Mode A Mode B Mode C

Purpose Normal operation.
Equipment delivers current 
to the connected series 
circuit.

Maintenance operation.
Equipment or series circuit 
can be serviced safely. 

Measurement possible. The 
series circuit insulation 
relative to ground can be 
measured.

Diagram

Cover 
placementa

Handle 
position

Horizontal. Turned 90 degrees counter 
clockwise from position A.

Turned 90 degrees 
clockwise from position A.

Series circuit Connected to the equipment. Shorted and grounded Disconnected from 
equipment, shorted and 
connected to measurement 
terminal.

Equipment Delivers current to the series 
circuit.

Shorted and grounded. Shorted and grounded.

Microswitchb Activated. Equipment is ON. Not activated. Equipment is 
OFF. 

Activated. Equipment is ON.

a) Only the three positions shown can be used. In another position, the cover does fit correctly.
b) When the cover is closed, the micro switch is activated. When the cover is open, the microcircuit is deactivated and 

the equipment shuts down.

CCR Series 
Circuit

Microswitch

CCR Series 
Circuit

Ground

Microswitch

CCR Series 
Circuit

Ground

Microswitch

Measurement
  socket
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8.8.2 Adjust operation mode
Remove cover
1. Open the lock (A).
2. Remove the cover (B). Use the handle.

Set operation mode
1. Install the cover (B). See the cover placement in § 8.8.1.
2. Close the lock (A).

B

A

B

A
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8.9 Operation mode

A series circuit with non-linear loads can be unstable. If the system is unstable, do the procedure below.

1. On the HMI, push the MENU button go to the Main menu.
2. Push the OPTIONS button to go to the Options menu.
3. Push the MODE button to go to the Mode menu.
4. Select the applicable mode: Normal is the factory default. Inductive is for cases where the current 

regulation is under the influence of inductive load and becomes unstable. The HMI now shows the Main 
screen. 

Note
The equipment automatically detects if the inductive mode is required. The alarm message 
‘DC BUS VOLTAGE TOO HIGH’ means that the series circuit is unstable.

Note
The equipment has these limitations in inductive mode:
- The power is limited to 85%.
- The LFD measurement is not active.
- In normal mode the equipment limits all current peaks higher than 7 A in less than 10 

ms, in inductive mode the current peak can reach 9 A.
- The output waveform is not a perfect sinusoidal wave.
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9 Troubleshooting

9.1 Preliminary checks
Before you do any adjustments on the equipment, examine:
- the alarm and back-indication signals on the display and/or remote control.
- if the power supply to the equipment is within the acceptance limits.
- if the fused input switches and auxiliary fuses are operational.
- if the input fuses and auxiliary fuses work normally.
- if all connectors are correctly in place.
- if no components show burned marks.
- if the input circuit breaker is in the ‘open’ position.
- wires are not interrupted or damaged.

9.2 Troubleshooting guide

9.2.1 Fault: Equipment does not turn ON
 

Table: 9.1 Equipment does not turn ON

WARNING
Do not troubleshoot unless you have read and understood all the information in chapter 2 
and you are qualified to work on high-voltage systems.
- Set the equipment to Local mode.
- Set the equipment to the brightness step OFF before you examine the series circuit.
- Switch OFF the main switch of the equipment;

If you do not obey the steps above, an increase of the power input can start an on cycling 
and restart the equipment. This results in a possible lethal output voltage.

Problem Possible cause Possible solution

No display indications. A problem with the power 
supply on the diode bridge 
PCB.

- Examine the transformer on the diode 
bridge.

- If necessary, replace the IGBT power bridge 
that contains the diode bridge PCB. 
See § 11.2.5.

- Examine the external 400 VAC/24VAC 
transformer.

- Replace the external transformer, if 
necessary.

The main switch is damaged. Replace the main switch. See § 11.2.23.

The input line filter is 
damaged.

Replace the line filter. See § 11.2.19.

The main contactor is 
damaged.

Replace the main contactor. See § 11.2.20 or § 
11.2.21

Replace the power supply PCB. See § 11.2.28.

Replace the CPU PCB. See § 11.2.2.
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9.2.2 Fault: Equipment does not go to the ON state
 

Table: 9.2 Equipment does not turn ON

Problem Possible cause Possible solution

Local mode:
- The display shows an alarm.
- The red lamp on top of the 

equipment goes on.

Remote mode:
- The red lamp on top of the 

equipment goes on.

One of the panels is opened. Close the panel.

- Examine the fuses on power 
supply PCB.

- Replace the fuses if 
necessary. See § 10.2.6.

- Examine the micro control 
PCB.

- Replace the CPU PCB if 
necessary. See § 10.2.2.

The precharge or main contactor is 
enabled when the equipment is in the 
OFF state when there is no command 
from the micro control PCB.
Or
The precharge or main contactor is 
not enabled when there is a command 
from the micro control PCB.

- Examine the contactors.
- Replace the contactors if 

necessary. See § 10.2.13 for 
the main contactor and § 
10.2.20 for the precharge 
contactor.

Examine the wiring connections.

- Examine the micro control 
PCB.

- Replace the CPU PCB if 
necessary. See § 10.2.2.

One or more phases are not present. - Examine the fuses on power 
supply PCB.

- Replace the fuses if 
necessary. See § 10.2.6..

- Examine the external 400 
VAC/24VAC transformer.

- Replace the external 
transformer, if necessary.

One of the fuses for the 3 phases is 
broken.

- Examine the main fuses.
- Replace broken fuse if 

necessary. See § 10.2.14.

The main DC (560V) is too low or not 
present.

- Examine the diode bridge.
- Replace the diode bridge 

PCB if necessary. 
See § 10.2.3 or 10.2.4.
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9.2.3 Fault: Equipment turns ON but suddenly de-energizes
 

Table: 9.3 Equipment turns ON but suddenly de-energizes

Problem Possible cause Solution (See)

After you pressed the ON 
button you record these 
problems:

Local mode:
- The display shows an 

alarm.
- The red lamp on top 

of the equipment goes 
on.

Remote mode:
- The red lamp on top 

of the equipment goes 
on.

The input AC line is delivers 
less than 360 VAC.

Examine the input VAC line.

- Examine the external 400 VAC/24VAC 
transformer.

- Replace the external transformer, if 
necessary.

Open circuit. Examine the connection of the high voltage 
cable to the field connection unit and to the 
power supply transformer

- Examine the output measure PCB.
- Replace the output measure PCB, if 

necessary. See § 11.2.27.

Overcurrent. - Examine the output measure PCB.
- Replace the output measure PCB, if 

necessary. See § 11.2.27.
A malfunction of the 
communication of the output 
measurement PCB.

The current on the primary 
winding of the power supply 
transformer is too high.

- Examine the IGBTs.
- If necessary, replace the IGBT power bridge 

that contains the IGBT. See § 11.2.10 or § 
11.2.11.

- Examine the CPU PCB.
- Replace the CPU PCB if necessary. 

See § 11.2.2.

- Examine the IGBT PCB.
- If necessary, replace the IGBT power bridge 

that contains the IGBT PCB. See § 11.2.10 
or § 11.2.11.
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9.2.4 Fault: equipment does not produce requested output current
 

Table: 9.4 Equipment does not produce the requested output current

9.3 Checks and measurements

9.3.1 Measure input voltage
1. Make sure that the main switch is OFF.
2. Make sure that  the input supply cables that come from the mains distribution panel are only connected to 

the equipment you want to measure.
3. Switch on the mains distribution to feed the equipment you want to measure.
4. Make sure that all connectors are securely tightened.
5. Measure the input voltage (V) to the equipment. Use a True RMS Multimeter.
6. Check the nameplate of the equipment and make sure that the input voltage is compatible with the 

equipment. 

9.3.2 Measure output current
1. Make sure that main switch is OFF.
2. Install a calibrated True RMS multimeter with a current clamp in the output circuit.
3. Switch on the equipment and set the equipment to the highest brightness step. See § 9.5. 
4. Read the output current from the True RMS multimeter.
5. Make sure that the measurement is accurate. Calibrate the output current again if necessary. 

9.3.3 Check fuse breaker and voltage of switch board
1. Make sure that the main switch is OFF.
2. Check the nameplate of the equipment to make sure that the fuse breaker voltage and the current rating 

of the switchboard is compatible with the equipment. Allowed variance by standards:
- IEC: +10 %
- FAA: ±10 %

3. Set the main switch to ON.
4. Measure the voltage (V) of the switchboard. Use a calibrated True RMS multimeter.

9.3.4 Calculate minimum insulation reistance of series circuit
1. Calculate the minimum insulation resistance of the series circuit. See § 8.2.15.
2. Make sure that the calculated values are higher than the values measured during commissioning.

9.3.5 Calculate resistance of series circuit
1. Calculate the resistance of the series circuit. See § 8.2.16.
2. Make sure that the calculated values are higher than the values measured during commissioning.

Problem Possible cause Solution (See)

The red lamp on top of 
the equipment goes on.

The equipment does not 
operate correctly.

- Examine the IGBT modules.
- If necessary, replace the IGBT power bridge 

that contains the IGBT module. 
See § 11.2.10 or § 11.2.11.

- Examine the output measure PCB.
- Replace the output measure PCB, if 

necessary. See § 11.2.27.

- Examine the IGBT PCB.
- If necessary, replace the IGBT power bridge 

that contains the IGBT PCB. See § 11.2.10 
or § 11.2.11.
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9.3.6 Measure cable capacitance
Measure the cable capacitance towards the ground as follows:
1. Make sure that the main switch is OFF.
2. Connect a multimeter to the regulator output cable. Use a Multimeter that has an internal resistance of 

10 MOhm.
3. Disconnect the 500 V DC power cable to the EFD module. The Multimeter now measures the discharge 

time of the cable capacitance from 400 V DC to 147 V DC.

If the cable capacitance is 1 µF, the measured voltage decreases from 400 V DC to 147 V DC (=0.37x400) in 
approximately 10 seconds.
If the voltage you measure with the LFD module connected is already 330 V DC, the cable leakage 
resistance is approximately 10 MOhm. In this case, the discharge time is approximately 5 seconds for a 
cable capacitance of 1 µF.
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10 Maintenance

10.1 Preventive maintenance schedule
 

Table: 10.1 Preventive maintenance schedule

WARNING

- Only personnel authorized to work on high-voltage equipment can do maintenance 
work on the equipment.

- Operate the equipment under local control when you do maintenance work on the 
equipment to prevent the equipment from being accidentally switched ON.

- Obey all local safety procedures.
- Make sure that you have obtained the necessary permissions according tot the local 

operation procedures and procedures regarding HV equipment.

Frequency Check Action

In accordance with ICAO 
Aerodrome Design Manual 
Part 9 Airport Maintenance 
practices or in accordance 
with local maintenance 
regulations. Adapt the 
maintenance frequency to 
the local conditions.

Examine the operation of 
the equipment on all 
brightness steps on all 
readings.

Use a PC to log the data, if required.

Input voltage. If the input voltage is not within the limits, tell the 
power company to adjust the voltage. Make sure 
that you do the necessary actions to align the 
input voltage with the input limitations.

Output current. Use a 
calibrated True RMS 
multimeter and/or a current 
clamp.

If the output current is not within tolerance, 
calibrate the output current again. 

Visually:
- if the wiring of the 

equipment and the 
circuit is not damaged.

- for rust spots and 
general damage.

- the housing for dust 
accumulation.

- all signs on the 
equipment for legibility 
and damage.

- Repair damaged or loose wires
- Replace damaged components. 
- Clean and repair rust spots.
- Clean the inside of the equipment wit an dry 

air blower.

If the electrical connections 
(e.g. input connections, 
output connections) are 
tightened correctly.

Tighten all the connections to make sure that all 
connections are tightened.
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10.2 Part replacement

10.2.1Required tools

Measurement tools
- True RMS Multimeter

- Multimeter
- Insulation tester "Megger" 500 V or 1000 V
- Clamp or A-meter true RMS scale 10 and 30 A

Tools
- Standard electrical and mechanical tool kit
- Screwdrivers with protection up to 1000 V
- Spanner set (ring or socket spanners)
- Allen keys 4 and 6 mm
- Torque screwdrivers (2 - 10 Nm and adaptors
- Short, slotted screwdriver
- Magnet rod for collecting loose items
- Angle socket wrench

WARNING

- Make sure you have read and understood all safety procedures and standards related 
to this equipment. See chapter 2.

- Make sure you switch OFF the power to the equipment. See § 9.3.
- Make sure you switch OFF the manual switch to remove all power to the equipment.

CAUTION
While you carry out maintenance, make sure that:
- You do not drop any screws or nuts inside the equipment cabinet. Collect all loose nuts 

and screws immediately.
- You can identify all cables you disconnect. Label the cables.
- If you need to change a PCB, you change the correct PCB.
- You have saved the equipment settings as a profile. To do this in the configuration 

software tool, see chapter 1.
- You put in the new parts exactly the same way as the parts you removed.
- After you replaced a part, test the equipment to make sure it is replaced correctly.

Note
See the electrical schemes inside the equipment cabinet for the connection schemes.

CAUTION
The output voltage of the 30 kVA / 6.6 A equipment can reach approximately 4600 V at full 
load. An isolating measurement transformer for use on the 5000 V AC line is 
recommended.

CAUTION
The current regulation is +/- 1%. To make an acceptable readjustment of the output 
current, the accuracy of the meter must be better than 0.5% for the adjusted value.
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10.2.2CPU PCB (EPS479) replacement

Parts: see § 13.8.
- CPU PCB
- Firmware

Remove panel
1. Remove the front panel. See § 10.3.

Disconnect
1. Disconnect the connectors and the wires (A).
2. Remove the fasteners (B).
3. Remove the CPU PCB (C). 

Install
1. Install the new CPU PCB.
2. Install the fasteners.
3. Connect all the wires.

Update the firmware
1. Update the firmware. See § 10.4.
2. Install the front panel. See § 10.3.

CAUTION

- If you install an OVP version of the CPU PCB, make sure that the diode bridge PCB is 
also an OVP version.

- If you install an non-OVP version of the CPU PCB, make sure that the diode bridge PCB 
is also an non-OVP version.

- Make sure that you update the correct firmware. The firmware code for an OVP version 
of the PCB ends with an ‘e’.

B

C

A

CAUTION
Connect the keyboard cable with the green side down.
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10.2.3Diode bridge and sensing PCB (EPS540 / EPS 541) replacement, small cabinet

Parts: see § 13.8.
- Diode bridge and sensing PCB

Prepare
1. Remove the front panel. See § 10.3.
2. Remove the precharge PCB. See § 10.2.21.

Remove
1. Disconnect the wires and connectors (A). 
2. Remove the fasteners (B).
3. Remove the diode bridge and sensing PCB (C).

Install
1. Wipe clean the copper plate (A).
2. Apply an even layer of conductive paste on the copper plate.
3. Install the new diode bridge on the new diode bridge and 

sensing PCB.
4. Make sure that the diode bridge makes good contact with the 

heatsink.

5. Connect all the wires.
6. Tighten the fasteners (B). Apply a torque of 2 Nm.
7. Install the precharge PCB. See § 10.2.21.
8. Install the front panel. See § 10.3.

Note
The IGBT PCB, IGBT and the diode bridge and sensing PCB together are the IGBT power 
bridge. IF one component breaks, replace the entire IGBT power bridge.

B

B

A

A

A

C

B

CAUTION
If there is a washer or a screw between the 
diode bridge and the heatsink, the heat 
dissipation is not sufficient.

B
A



A.07.375e - Edition 2.0 93

Maintenance

10.2.4Diode bridge and sensing PCB (EPS 497) replacement, big cabinet

Parts: see § 13.8.
- Diode bridge and sensing PCB

Prepare
1. Remove the lower front panel. See § 10.3.
2. Remove the precharge PCB. See § 10.2.22.

Remove diode bridge
1. Remove the fasteners (A).
2. Disconnect the wires (B). 
3. Remove the fasteners (C).
4. Remove the diode bridge (D).

Install - 1
1. Wipe clean the heat sink where you install the new diode 

bridge.
2. Apply an even layer of conductive paste on the back side of 

the new diode bridge.
3. Install the new diode bridge.
4. Make sure that the diode bridge makes good contact with the 

heatsink.

5. Tighten the fasteners (A). Apply a torque of 4 Nm.
6. Install the new sensing PCB.
7. Connect all the wires to the new diode bridge PCB.
8. Tighten the fasteners (B). Apply a torque of 2 Nm.

Install - 2
1. Install the precharge PCB. See § 10.2.22.
2. Install the lower front panel. See § 10.3.4.

Note
The IGBT PCB, IGBT and the diode bridge and sensing PCB together are the IGBT power 
bridge. IF one component breaks, replace the entire IGBT power bridge.

C

B

C

AD

B

C

CAUTION
If there is a washer or a 
screw between the diode 
bridge and the heatsink, 
the heat dissipation is not 
sufficient.

A B
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10.2.5Display and keyboard replacement

Parts: see § 13.8.
- Display/keyboard panel

1. Remove the display/keyboard panel. See § 10.3.
2. Install the new display/keyboard panel. See § 10.3.

10.2.6Fuses on the power supply PCB (EPS480) replacement

Parts: see § 13.8.
- Fuses. See also § 13.5.

Remove panel
1. Remove the lower front panel. See § 10.3.4.

Replace
1. Push, turn counterclockwise and remove the fuse (A). It is 

possible that only one fuse is broken. Only replace the broken 
fuse.

2. Install the new fuse. 

Install
1. Install the lower front panel. See § 10.3.4.

10.2.7IGBT PCB (EPS477 / EPS 478) replacement, small cabinet

Parts: see § 13.8.
- IGBT PCB

Remove panel
1. Remove the front panel. See § 10.3.

A

Note
The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the IGBT 
power bridge. If one component breaks, replace the entire IGBT power bridge. 
The illustrations for this procedure show the situation for the 2.5 kVA and 10 kVA cabinets. 
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Disconnect
1. Disconnect the connectors and the wires (A).
2. Remove the fasteners (B).
3. Remove the IGBT PCB (C). 

Install

1. Make sure that spring number 7 (A) of the IGBT is removed. 
Once a spring has been removed, it cannot be installed back.

2. Install the new IGBT PCB.
3. Connect all the wires.
4. Install the front panel. See § 10.3.

10.2.8IGBT PCB (EPS496) replacement, big cabinet

Parts: see § 13.8.
- IGBT PCB

Remove panel
1. Remove the lower front panel. See § 10.3.

A

C

A

B

CAUTION
when you tighten the fasteners, only apply force vertically. Use an allen key 
screwdriver or an allen key handle instead of a socket wrench or a ratchet. Sideways 
force can cause the components to get damaged.

A

Note

- The IGBT PCB, IGBT module, and the diode bridge and sensing PCB together are the 
IGBT power bridge. If one component breaks, replace the entire IGBT power bridge. 

- The procedure shows the IGBT PCB at the right-hand side. The procedure for the IGBT 
PCB at the left-hand side is similar.
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Remove
1. Disconnect the wires (A).
2. Remove the fasteners (B).
3. Remove the capacitors (C).
4. Remove the fasteners (D).
5. Remove the IGBT PCB.

Remove the spring from the IGBT
1. Make sure that spring number 7 (A) of the IGBT is removed. 

Once a spring has been removed, it cannot be installed back.

Install

1. Install the new IGBT PCB (A) on the IGBT.
2. Install the fasteners (B) crosswise. Apply a torque of 4 Nm.
3. Install the capacitors (C).
4. Install the fasteners (D). Apply a torque of 4 Nm.
5. Connect the wires (E). 

E

A

A

C

B

D

D

A

CAUTION
when you tighten the fasteners, only apply force vertically. Use an allen key 
screwdriver or an allen key handle instead of a socket wrench or a ratchet. Sideways 
force can cause the components to get damaged.

A

E

E

C

D

B

B
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10.2.9IGBT replacement, small cabinet

Parts: see § 13.8.
- IGBT

Remove panel
1. Remove the front panel. See § 10.3.

Remove - 1
1. Remove the fasteners (A).
2. Remove the capacitor plate (B).
3. Remove the IGBT PCB. See § 10.2.7..

Remove - 2
1. Disconnect the wire (A).
2. Remove the fasteners (B).
3. Remove the IGBT (C). 

Note
The IGBT PCB, IGBT and the diode bridge and sensing PCB together are the IGBT power 
bridge. IF one component breaks, replace the entire IGBT power bridge.

A

B

B

C

A

B
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Install - 1
1. Wipe clean the heat sink below the IGBT (A).
2. Apply an even layer of conductive paste on the rear of the 

IGBT (the side that touches the heat sink).
3. Tighten the fasteners (B) crosswise. Apply a torque of 4 Nm.

Install - 2
1. Make sure that spring number 7 of the IGBT is removed. 

Once a spring has been removed, it cannot be installed back.
2. Install the IGBT PCB. See § 10.2.7.
3. Install the capacitor plate.
4. Connect the wires.
5. Install the fasteners (A). Apply a torque of 4 Nm.
6. Install the front panel. See § 10.3.

10.2.10IGBT replacement,  big cabinet

1. Remove the IGBT PCB. See § 10.2.8.
2. With a new IGBT, install the IGBT PCB. See § 10.2.8.

B

A

B

A

Note
The IGBT PCB, IGBT and the diode bridge and sensing PCB together are the IGBT power 
bridge. IF one component breaks, replace the entire IGBT power bridge.
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10.2.11Lightning arrestors replacement

Parts: see § 13.8.
- Lightning arrestor(s)

Remove panel
1. Remove the side panels. See § 10.3.

Remove
1. Disconnect the wires (A). 
2. Remove the fasteners (B).
3. Remove the lighning arrestors assembly (C).

Install
1. Install the new lightning arrestor assembly.
2. Instal the wires.
3. Install the side panels. See § 10.3.

10.2.12Line filter replacement

Parts: see § 13.8.
- Line filter

Remove panel
1. Remove the side panels. See § 10.3.
2. Remove the lower rear panel. See § 10.3.

Note
The number of lightning arrestors can be different from the illustrations, depending on the 
output power.

A

B C

B
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Remove
1. Disconnect the wires (A). 
2. Remove the fasteners (B).
3. Remove the line filter (C).

Install
1. Install the new line filter.
2. Install the wires.
3. Install the lower rear panel. See § 10.3.
4. Install the side panels. See § 10.3.

10.2.13Main contactor replacement

Parts: see § 13.8.
- Main contactor

Remove panel
1. Remove the lower front panel. See § 10.3.

Disconnect
1. Loosen the screws (A).
2. Disconnect the wires (B). 
3. Remove the main contactor (C). Use a screwdriver as a lever 

to release the manual switch from the rail (D).

B

B

C

B A

WARNING
Make sure that you switched OFF the power to the equipment. See § 8.3.
Make sure that you switched OFF the external disconnection device to remove all power 
to the equipment.

D

B

C
A

A

B
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Install
1. Install the new main contactor.
2. Connect all the wires. 
3. Tighten the screws (A). Apply a torque of 4 (big cabinet) or 5 

(small cabinet) Nm.
4. Install the lower front panel. See § 10.3.

10.2.14Main fuses replacement

Parts: see § 13.8.
- Fuses. See also § 13.5.

Remove panel
1. Remove the lower front panel. See § 10.3.4.

Replace
1. Open the fuse holder (A).
2. Replace the fuse (B).
3. Close the fuse holder.

Install
1. Install the lower front panel. See § 10.3.4.

A

A

B
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10.2.15Manual switch replacement

Parts: see § 13.8.
- Manual switch

Remove panel
1. Remove the lower front panel. See § 10.3.

Disconnect
1. Loosen the screws (A).
2. Disconnect the wires (B). 
3. Remove the manual switch (C). Use a screwdriver as a lever 

to release the manual switch from the rail (D).

Install
1. Install the new manual switch.
2. Connect all the wires. 
3. Tighten the screws (A). Apply a torque of 4 Nm.
4. Install the lower front panel. See § 10.3.

WARNING
Make sure you switch OFF the power to the equipment. See § 8.3.
Make sure you switch OFF the external disconnection device to remove al power to the 
equipment.

A

B

B

D

A

C

A

A
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10.2.16Output filter replacement, small cabinet

Parts: see § 13.8.
- Output filter
- Input filter

Remove panel
1. Remove the side panels. See § 10.3.

Remove
1. Disconnect the wires (A). 
2. Remove the fasteners (B).
3. Remove the output filter plate (C).

Disconnect
1. Disconnect the fasteners (A).
2. Remove the aoutput filter plate (C) from the back plate (B).

- Always replace the input filter and the output filter together. 
- The number of filters and capacities can be different from the illustrations, depending 

on the output power.
- For equipments up to 7.5 kVA, the output filter is not installed on a plate, but directly on 

the housing. In this case, replace all individiual filter parts. 

CA

B

B

B

A

C
A



104 A.07.375e - Edition 2.0

Maintenance

Install
1. Install the new  output filter plate.
2. Connect the wires.
3. Tighten the fasteners (A). Apply a torque of 6 Nm.
4. Install the side panels. See § 10.3.

10.2.17Output filter replacement, big cabinet

Parts: see § 13.8.
- Output filter
- Input filter

Remove panel
1. Remove the side panels. See § 10.3.

Remove
1. Disconnect the wires (A). 
2. Remove the fasteners (B).
3. Remove the output filter plate (C).

A

- Always replace the input filter and the output filter together. 
- The number of filters and capacities can be different from the illustrations, depending 

on the output power.

B

B

A
A

C
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Install
1. Install the new output filter plate.
2. Install the wires.
3. Tighten the fasteners (A). Apply a torque of 6 Nm.
4. Install the side panels. See § 10.3.

10.2.18Output measure PCB (EPS442) replacement

Parts: see § 13.8.
- Output measure PCB

Remove panels
1. Remove the upper rear panel. See § 10.3.
2. Remove the screws (A).
3. Remove the box panel (B).

Disconnect
1. Disconnect the wires and connectors (A). 
2. Remove the fasteners (B).
3. Remove the output measure PCB (C).

Install
1. Install the new output measure PCB.
2. Install the wires and connectors.
3. Install the box panel.
4. Install the upper rear panel. See § 10.3.

A
A

A

A

B

BA

A

CB B

BB



106 A.07.375e - Edition 2.0

Maintenance

10.2.19Power supply PCB (EPS480) replacement

Parts: see § 13.8.
- Power supply PCB

Remove panel
1. Remove the front panel. See § 10.3.4.

Disconnect
1. Disconnect the connectors and the wires (A).
2. Remove the fasteners (B).
3. Remove the power supply PCB (C). 

Install
1. Install the new power supply PCB.
2. Connect all the wires.
3. Install the front panel. See § 10.3.4.

10.2.20Precharge contactor replacement

Parts: see § 13.8.
- Precharge contactor

Remove panel
1. Remove the lower front panel. See § 10.3.

Disconnect
1. Loosen the screws (A).
2. Disconnect the wires (B). 
3. Remove the precharge contactor (C). Use a screwdriver as a 

lever to release the manual switch from the rail (D).

B
A

B

B

A

A

C
A

B

WARNING
Make sure that you switched OFF the power to the equipment. See § 8.3.

D

B

C
A

A

B
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Install
1. Install the new precharge contactor.
2. Connect all the wires. 
3. Tighten the screws (A). Apply a torque of 4 (big cabinet) or 5 

(small cabinet) Nm.
4. Install the lower front panel. See § 10.3.

10.2.21Precharge PCB (EPS546) replacement, small cabinet

Parts: see § 13.8.
- Precharge PCB

Remove panel
1. Remove the lower front panel. See § 10.3.

Disconnect
1. Remove the fasteners (A).
2. Remove the precharge PCB (B). 
3. Disconnect the connectors (C).

Install
1. Connect the connector.
2. Install the new  precharge PCB.
3. Tighten the fasteners with a torque of 2 Nm.
4. Install the front panel. See § 10.3.

A

BA C
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10.2.22Precharge PCB (EPS456) replacement, big cabinet
Remove panel
1. Remove the lower front panel. See § 10.3.4.

Remove
1. Disconnect the connector (A). 
2. Remove the fasteners (B). 
3. Carefully remove the precharge PCB (C). 
4. Remove the fasteners (D).
5. Remove the electrical wires. 

Install
1. Connect all the wires.
2. Tighten the fasteners (A). Apply a torque of 4 Nm.
3. Install the new precharge PCB.
4. Install the lower front panel. See § 10.3.4.

10.2.23Remote control PCB (EPS495) replacement

Parts: see § 13.8.
- Remote control PCB or remote control PCB SIN

Remove panel
1. Remove the upper rear panel. See § 10.3.

C B

B

D

B

A

A

Note
The procedure is similar for the replacement of the remote conrol PCB SIN.
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Disconnect
1. Disconnect the connectors and the wires (A).
2. Remove the fasteners (B).
3. Remove the remote control PCB (C). 

Install
1. Set the dip-switches of the new remote control PCB. See § 12.3. 
2. Install the new remote control PCB.
3. Connect all the wires.

4. Install the upper rear panel. See § 10.3.

10.2.24Series Connection Box (SCB) replacement (option)

Parts: see § 13.8.
- Series Connection Box (SCB)

Prepare
1. Switch OFF the power supply. See § 9.3.
2. Make sure that the circuit is earthed.

Remove panel
1. Loosen the fasteners (A).
2. Remove the box panel (B).

B

A

A

C

CAUTION
Depending on the configuration of the equipment, other wires need to be connected. 
These can be different from the illustration above.

A

A

B
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Remove
1. Loosen the screws (A).
2. Disconnect the series circuit cables (B).
3. Disconnect the wires and connectors (C).
4. Loosen the screws (D).
5. Carefully remove the SCB (E).

Install
1. Install the new SCB.
2. Put the series circuit cables through the stress-relief clamps.
3. Tighten the screws of the stress-relief clamps.
4. Install all the wires and connectors.
5. Install the box panel.

10.2.25Series CutOut (SCO) replacement (option)

Parts: see § 13.8.
- Series CutOut (SCO)

Prepare
1. Switch OFF the power supply. See § 9.3.
2. Make sure that the circuit is earthed.
3. Open the lock (A).
4. Remove the cover (B). Use the handle.

B

D

A

A

C

E

D

D

C

B

A
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Remove
1. Loosen the screws (A1).
2. Remove the series circuit cables from the earthing bar (A2).
3. Disconnect the series circuit cables (A).
4. Loosen the screws (B1).
5. Disconnect the output cables (B).
6. Loosen the screw (C1)
7. Disconnect the earthing wire (C).
8. Remove the bolts (D).
9. Remove the SCO.

Connect micro switch
1. Disconnect the cables to the micro switch (A).
2. Connect the cables to the micro switch (A) in the new SCO.

Install
1. Install the new SCO.
2. Install the bolts (D).
3. Connect the earthing wire (C). Use the screw connection 

(C1).
4. Connect the output cables (B).
5. Tighten the screws B1.
6. Connect the series circuit cables (A).
7. Tighten the screws (A1).
8. Connect the wires to the earthing bar (A2).

- Make the connection of the shield of the cable to the 
earthing bar.

- If there is no shield on the cable, connect a clamp to the 
outside of the cable.

B1

B

A1

A

A2

C

D

D

C1

A

B1

B

A1

A

A2

C

D

D

C1
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Finish
1. Install the cover of the SCO (A).

10.3 Remove panels
The panels of the equipment can be removed for installation or maintenance procedures.

10.3.1 Remove the display / keyboard panel of the small cabinet

Disconnect HMI
1. Remove the front panel. See § 10.3.4.
2. Disconnect the wires (A) to the HMI from the CPU PCB (B).
3. Disconnect the earthing wire (C).

A

WARNING

- Do not operate the equipment with any of the panels removed.
- Do not mix panels from different equipments.
- Always connect the earthing wires before you install the panels.
- The panels can be heavy, especially the side panels.
- Do not change or lock the panel switches. A Panel switch sees if a panel is installed or 

not.

Note
The panels differ in size and number of screws. The illustrations below show the principle.

A

CB A
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Remove panel
1. Remove the top panel. See § 10.3.3.
2. Remove the screws (A).
3. Carefully remove the panel (B).

10.3.2 Remove the display / keyboard panel of the big cabinet

Disconnect HMI
1. Remove the lower front panel. See § 10.3.4.
2. Disconnect the wires (A) to the HMI from the CPU PCB (B).
3. Disconnect the earthing wire (C).

Remove panel
1. Remove the screws (A).
2. Carefully remove the panel (B).

CAUTION
Do not damage cables and/or 
connectors.

B

A

A

CB A

CAUTION
Do not damage cables and/or 
connectors.

B

A
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10.3.3 Top panel (small cabinet)

Disconnect HMI
1. Remove the front panel. See § 10.3.4.
2. Disconnect the wires (A) to the HMI from the CPU PCB (B).
3. Disconnect the earthing wire (C).

Remove
1. Remove the screws (A).
2. Remove the top panel (B).

Disconnect wires
1. Disconnect the green/yellow earthing wires. The wires have a 

fast-on connector.

A

CB A

B A
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10.3.4Generic panels
Remove panel
1. Set the manual switch to the ‘OFF’ position.
2. Remove the screws (A) from the bottom to the top.

3. Carefully remove the panel (B).

Disconnect wires
1. Disconnect the green/yellow earthing wires. The wires have a 

fast-on connector.

10.4 Firmware update

10.4.1 Firmware update procedure

Tools:
- PC with serial port connection
- Firmware update dongle: ‘Pin to Pin DB9P & DB9S cable’
- Correct firmware upload file

1. Install the software to upload the firmware. See § 10.4.2.
2. Change the SD flash file paths, if necessary. See § 10.4.3.
3. Do a check on the equipment parameters. See § 10.4.4.
4. Update the firmware. See § 10.4.5.
5. Start the equipment after a firmware update. See § 10.4.6.

WARNING
The panels are heavy. Also, the 
momentum of the panel can cause 
damage to the panel and the 
screws if you remove the top 
screws first.

CAUTION
Do not damage cables and/or 
connectors.

1

2

3

A
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10.4.2 Install the software to upload the firmware

Install the software
1. Unzip the file ‘sdflash.zip’ to the default path of D:\sdflash. 

2. Run the program SDFlash.exe. 
3. Select File>Open Project.
4. Select the ‘F2812SerialFlash.sdp’ project from the ‘sdflash’ directory. 
5. If you opened the program for the fist time, select the correct Emulator Address/ID. 

6. Go to File>Exit. 
7. Click Save. 

Do a check on the port settings
1. Go to Start>Control Panel>System>Hardware tab>Device Manager>Ports>USB Serial Port.
2. Right-click on USB Serial Port.
3. Select Properties.
4. Select the tab Port Settings.
5. In the Advanced Settings for COM window, do these steps:

- Make sure that the COM Port Number is correct. Select the correct Emulator Address/ID (see earlier 
in this procedure).

- Change Receive (Bytes) to 4096.
- Change Transmit (Bytes) to 4096.
- Change Latency Timer (msec) to 16. 

Note
If you extract the zip file to a different location, see § 10.4.3.

Note
This is the same process as selecting the correct COM-port address, where C4 would 
equal COM 4. Refer to the device manager of the PC to find the correct address. You 
can change this setting later from the Project >Settings >Target tab>Emulator 
Address/ID drop down list.
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10.4.3 Change the SD Flash file paths

1. Go to Project>Settings.
2. In the indicated tabs, change the indicated fields to the correct file path.

 

3. Click OK.

10.4.4 Do a check of the equipment parameters
1. Start the configuration software tool. See § 7.2.
2. Go to the Configuration screen.
3. Go to the Identification tab.
4. Push the Read button to show the firmware details.
5. Make sure that the equipment parameters below match these of the filename of the required firmware 

version:
- Single Phase (CRE) or Tri-phase (VIS) 
- Input Voltage: 230V range or 400V range
- CCR Power Rating in kVA
- SHVS installed or SHVS not installed.
- The type of control system. This is PPT unless specified. 

6. Stop the configuration software tool. See § 7.4.  
7. Switch OFF the equipment. See § 9.2. 
8. Make sure that the manual switch is in the OFF position. See § 9.3.

10.4.5 Update the firmware

Prepare the equipment
1. Remove the lower front panel. See § 10.3.4.
2. Remove the watch-dog jumper from the CPU PCB (EPS479). 

See § 12.1.
3. Connect the firmware update dongle (A) between the PC and 

the equipment.
4. Click on SDFlash.exe.
5. Do a check if F2812SerialFlash.sdp loads.
6. If not, see § 10.4.2 and load the correct project. 
7. Switch ON the equipment. See § 9.1. When the equipment is 

ready for the firmware upload, the HMI is blank.
8. If the HMI is not blank, see § 10.4.2 and load the correct 

project.

Note
Do this procedure if you extracted the zip file ‘sdflash.zip’ to a different location than 
D:\sdflash.

Tab Field

Target Driver

Board File

Erase Algorithm

Programming Algorithm

Verify Algorithm

A
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Upload the firmware
1. Go to Project>Settings>Programming tab>Flash Data File field.
2. Select the correct firmware version file from the files with a *.out extension.
3. Go to Device>Flash. If asked to save changes, click yes.   
4. Make sure that the Erase, Program and Verify checkboxes are checked.
5. Click Start.
6. Wait until the upload is complete.
7. Close the SDFlash program. 

10.4.6 Start the equipment after a firmware update

Start the equipment again
1. Switch OFF the equipment. See § 9.2. 
2. Make sure that the manual switch is in the OFF position. See § 9.3.
3. Install the watch-dog jumper on the CPU PCB. 
4. Switch ON the equipment. See § 9.1. 

Do a check if the firmware is correctly updated
1. Make sure that the firmware data on the lower line of the main menu on the HMI is correct. 
2. Start the configuration software tool. See § 6.2.
3. Go to the Configuration screen.
4. Go to the Identification tab.
5. Push the Read button to show the firmware details.

Disconnect the cable and install the front panel
1. Switch OFF the equipment. See § 9.2. 
2. Make sure that the manual switch is in the OFF position. See § 9.3.
3. Disconnect the firmware update dongle.
4. Install the lower front panel. See § 10.3.4.
5. Switch ON the equipment. See § 9.1. 
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11 PCB drawings and settings

11.1 CPU PCB (EPS479)

11.1.1 Printed Circuit Board (PCB)

11.1.2 LEDs
 

Table: 11.1 CPU PCB LED functions

LDX3 LDX2

LD3

LD2

LDX4

LD1

LDX1

LED Color Function

LDX1 Red The LED is red when the voltage for the power supply is +5V DC (generated on the PCB).

LDX2 Red The LED is red when the voltage is +5V DC.

LDX3 Red The LED is red when the voltage from the power supply PCB is +12 V DC.

LDX4 Red The LED is red when the CPU operates.

LD1 Green The LED is green when the voltage for the power supply on the PCB  is +5 V DC (generated 
on the PCB). 

LD2 Green The LED is green when the voltage for the power supply on the PCB  is +3.3 V DC 
(generated on the PCB).

LD3 Green The LED is green when the voltage for the powers supply on the PCB is +1.8 V DC 
(generated on the PCB).
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11.2 Power supply PCB (EPS480)

11.2.1 Printed Circuit Board (PCB)

11.2.2 LEDs
 

Table: 11.2 Power supply PCB LED functions

LD3 LD5 LD6 LD7 LD8

LD11

F2

F1
LD4

LD1

LD2
LD9

LD10

LD12

LED Color Function

LD1 Green The LED is green when the voltage for the fans, if applicable is +24 V DC (generated on 
the PCB)

LD2 Red The LED is red when the voltage of the power supply on the PCB is 12 V DC.

LD3 Red The LED is red when the fan connected to J8 is active.

LD4 Red The LED is red when the fan connected to J10 is active.

LD5 Red The LED is red when the fan connected to J12 is active.

LD6 Red The LED is red when the fan connected to J14 is active.

LD7 Red The LED is red when the fan connected to J16 is active.

LD8 Red The LED is red when the fan connected to J18 is active.

LD9 Red The LED is red when the input voltage after the diode bridge PT is 24 V DC (nominal).

LD10 Red The LED is red when the voltage of the power supply on the PCB is 20 V DC.

LD11 Red The LED is red when the sense input line voltage is 24 V AC (nominal).

LD12 Green The LED is green when the voltage from the 50 kHz power supply on the PCB is 48 V DC.
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11.2.3 Fuses
 

Table: 11.3 Power supply PCB Fuses

11.3 Remote control PCB (EPS 495)

11.3.1 Printed Circuit Board (PCB)

11.3.2 LEDs
 

Table: 11.4 Remote control PCB LED functions

F1 1.6 A

F2 2.5 A

LD2

J1 J2

J5 J6
J7 J8

LD3

LD5

JP6

JP7

J19

JP4

JP5
JP3

JP2

J16

J15

J20

LD4

LD1

LED Color Function

LD1 Green The LED is green when the voltage of the power supply on the PCB is 12 V DC.

LD2 Green The LED is green when the voltage from the DCDC1, generated on the PCB, is + 5 V DC 
insulated.

LD3 Green The LED is green when the voltage from the DCDC2, generated on the PCB, is + 5 V DC 
insulated.

LD4 Red The LED flashes red when the U5 CPU is active.

lD5 Red The LED flashes red when the U6 CPU is active.
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11.3.3 Jumper settings
 

Table: 11.5 Remote control PCB jumper settings

Jumper Position Function

JP2 insert enable TX serial channel 1 termination resistance

JP3 insert enable RX serial channel 1 termination resistance

JP4 insert enable TX serial channel 2 termination resistance

JP5 insert enable RX serial channel 2 termination resistance

JP6 position 1-3 and position 2-4 ethernet channel 1: enable

position 3-5 and position 4-6 serial channel 1: enable

JP7 position 1-3 and position 2-4 ethernet channel 2: enable

position 3-5 and position 4-6 serial channel 2: enable

J15 position 2-3 serial channel 1: RS485 configuration

position 1-2 serial channel 1: RS422 configuration (not used)

3

4

5

6

1

2

3

4

5

6

1

2

3

4

5

6

1

2

3

4

5

6

1

2

2 13

2 13
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11.3.4 Multiwire / J-Bus connection scheme

 

J16 position 2-3 serial channel 1: RS485 configuration

position 1-2 serial channel 1: RS422 configuration (not used)

J19 position 2-3 serial channel 2: RS485 configuration

position 1-2 serial channel 2: RS422 configuration (not used)

J20 position 2-3 serial channel 2: RS485 configuration

position 1-2 serial channel 2: RS422 configuration (not used)

Jumper Position Function

2 31

2 31

1

3
2

1

3
2

1

3
2

1

3
2

Note
The table below shows the standard remote 
control configuration for the signals. If you 
want another configuration, contact ADB 
Safegate.

25 17 9 1

32 24 16 8
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Table: 11.6 Factory set terminal assignments for remote control connections with multiwire and 
single J-Bus

Function Terminal number on 32-pole 
connector

Relay number on Remote Control 
PCB (unless indicated otherwise)

Control signals (fixed)

Step 1 1 J1.1

Step 2 2 J1.2

Step 3 3 J1.3

Step 4 4 J1.4

Step 5 5 J1.5

ON 6 J1.6

CCR OFF from HVCS 8 J1.7

Feedback signals (fixed)

Step 1 9 J5.1

Step 2 10 J5.2

Step 3 11 J5.3

Step 4 12 J5.4

Step 5 13 J5.5

ON (step1,2...5) / OFF (OFF or 
Standby Step0)

19 J5.6

Feedback signals (configurable): the values below are default values, for configuration options (for the 
options, see the table that follows)

Disable local/remote 14 J5.7 (NC)a

28 J5.8

Open circuit 16 J6.1a

Overcurrent 20 J6.2a

Bad regulation 22 J6.3a

15 J6.4 (CM)

Lamp fault 23 J6.5a

EFD warning 24 J6.7a

EFD error 25 J6.8a

High temperature alarm 27 J7.1a

Short circuit 29 J7.2a

Lamp fault warning 21 J7.3a

External signals (fixed)

24 CRE doorswitch (power input door)

26 CRE doorswitch (power input door)

7



A.07.375e - Edition 2.0 125

PCB drawings and settings

 

Table: 11.7 Factory set terminal assignments for remote control connections with multiwire dual J-
Bus

17

18

J-Bus interface (fixed)

RS485 BusA GND 30 DB9.3

RS485 Data - 32 DB9.2

RS485 Data + 31 DB9.1

a) Configurable with HMI

Function Terminal number on 32-pole 
connector

Relay number on Remote Control 
PCB (unless indicated otherwise)

Function Terminal number on 32-pole 
connector

Relay number on Remote Control 
PCB (unless indicated otherwise

Control signals (fixed)

Step 1 1 J1.1

Step 2 2 J1.2

Step 3 3 J1.3

Step 4 4 J1.4

Step 5 5 J1.5

ON 6 J1.6

CCR OFF from HVCS 8 J1.7

Feedback signals (fixed)

Step 1 9 J5.1

Step 2 10 J5.2

Step 3 11 J5.3

Step 4 12 J5.4

Step 5 13 J5.5

ON (step1,2...5) / OFF (OFF or 
Standby Step0)

19 J5.6

Feedback signals (configurable): 

Disable local/remote 14 J5.7 (NC)a

Open circuit 16 J6.1a

Overcurrent 20 J6.2a

Bad regulation 15 J6.4 (CM)

EFD error 25 J6.8a

Lamp fault warning 21 J7.3a
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External signals (fixed)

7

17

18

J-Bus interface (fixed)

RS485 BusA GND 30 DB9.3

RS485 Data - 32 DB9.2

RS485 Data + 31 DB9.1

RS485 BusB GND 27 DB92.3

RS485 Data + 28 DB92.1

RS485 Data - 29 DB92.2

a) Configurable with HMI

Function Terminal number on 32-pole 
connector

Relay number on Remote Control 
PCB (unless indicated otherwise
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Multiwire and J-Bus connection

A Equipment
B Remote control equipment
C Remote control PCB - input signals
D Remote control connector on the equipment
E Opto coupler
F 48 V DC power supply
G Isoground
H +48 V DC
I Rel com
J Remote control PCB - feedback signals
K Relais
L 24 V DC power supply
M J-Bus RS485 connection
N J-Bus RS485 interface

D

A

C

B

J

E F

L

M

G
I

H

N

K
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11.4 IGBT PCB (EPS477 / EPS 496)

11.4.1 Printed Circuit Board (PCB) EPS477 for2s Semix

11.4.2 LEDs EPS477 for 2s Semix
 

Table: 11.8 IGBT PCB LED functions

LDX1
LDX2

LDX3
LDX4

LDX4
LDX3

LDX2
LDX1

LED Color Function

LDX1 Red The LED is red when the voltage for the high side IGBT, generated on the PCB, is +18 V 
DC.

LDX2 Red The LED is red when the voltage for the high side IGBT, generated on the PCB, is -5 V 
DC.

LDX3 Red The LED is red when the voltage for the low side IGBT, generated on the PCB, is +18 V 
DC.

LDX4 Red The LED is red when the voltage for the low side IGBT, generated on the PCB, is -5 V 
DC.
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11.4.3 Printed Circuit Board (PCB) EPS496 for 3s Semix

A LDX1 - red
B LDX2 - red
C LDX3 - red
D LDX4 - red
E LDX4 - red

11.4.4 LEDs EPS477 for 1s and 2s Semix
 

Table: 11.9 IGBT PCB LED functions

LDX1LDX2LDX3LDX4

LDX5

LED Function

LDX1 The LED is red when the voltage for the high side IGBT, generated on the PCB, is +18 V DC.

LDX2 The LED is red when the voltage for the high side IGBT, generated on the PCB, is -5 V DC.

LDX3 The LED is red when the voltage for the low side IGBT, generated on the PCB, is +18 V DC.

LDX4 The LED is red when the voltage for the low side IGBT, generated on the PCB, is -5 V DC.

LDX5 The LED is red when the voltage for logic IC power supply is + 5 V DC.
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11.5 Output measure PCB (EPS442)

11.5.1 Printed Circuit Board (PCB)

11.5.2 LEDs
 

Table: 11.103 Phase bridge PCB LED RUN light functions

LD1

LED Color Function

LD1 Red The LED flashes red is the CPU on the PCB is active.
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11.6 Diode bridge and sensing PCB (EPS540 / EPS 541 / EPS 497)

11.6.1 Printed Circuit Board (PCB)

11.6.2 LEDs
 

Table: 11.11Diode bridge and sensing PCB LED functions

LDX1

LDX3

LDX4

LDX2

LED

LDX1 The LED is red when the nominal voltage for the IGBT test is 24 V DC.

LDX2 The LED is red when the voltage from the power supply PCB is +5 V DC.

LDX3 The LED is red when the voltage from the 50 kHz power supply on the PCB is +18 V DC.

LDX4 The LED is red when the nominal voltage for the IGTBT bridge bus is 560 V DC.
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11.7 Test parameters

11.7.1 Analog channels 
 

Table: 11.12Analog channels

11.7.2 Input
 

Table: 11.13Test input parameters

Channel Description Value range

0 Temperature 17000 - 32000

1 Temperature 27000 - 32000

2 I bridge 100 - 2000

3 V bridge 0 - 30000

4 V in ± 31000

5 Aux 1 x = 0

6 Aux 2 x = 0

Ref1 V reference 1 ± 54000

Ref2 V reference 2 ± 2800

Connector Function

PB0 Fan 1

PB1 If 1, the Precharge control switch is enabled

PB2 If 1, the Main control switch is enabled

PB3 Fan 2

PB4 If 0, SCO/panel is open

PB5 If 1, BUS fuse is not damaged

PF0 If 0, the overcurrent protecion is ON

PF1 If 0, the overcurrent protecion is ON
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11.7.3 Outputs
 

Table: 11.14Test output parameters

11.7.4 External inputs
I0 to I15: Inputs from multiwire PCB.

11.7.5 External outputs
O0 to O15: Outputs from multiwire PCB.

11.7.6 PIC analog channels
 

Table: 11.15PIC anaolg channels test

Connector Function

PE0 0 = Main control switch enabled

PE1 0 = Precharge control switch enabled

PE2 0 = Gate H activation

PE3 1 = Fan enabled

PE4 Display font

PE5 1 = Display back lighting ON

PE6 1 = Red fault LED ON

PE7 1 = Green power LED ON

Channel Description

Div_I Number of divisions of output current

Div_V Number of divisions of output voltage

EFD Nomber of divisions of EFD

Phase Phase displacement beteween V and I (x 1000)
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12 Technical data

12.1 Specifications
 

Table: 12.1 Technical specifications

 

Table: 12.2 Output specifications

Item Description

Rated input voltage [V]  400 V AC (± 10%) three phases

Rated frequencies [Hz] 50 or 60

Current regulation limits Current regulation is guaranteed under the following conditions (± 0.1 
A):
- Under IEC 61822 environmental conditions
- For nominal input voltage under IEC or FAA standard conditions
- From full load to short circuit

Current regulation modes Two preset regulation modes:
- normal mode (for linear loads)
- inductive mode (for non-linear loads (e.g. LED loads))

Average efficiency at full load 92 to 94% depending on the size of the equipment, under nominal 
resistive load, nominal output current and nominal input voltage

Power factor at output The power factor exceeds the IEC and FAA requirements. The power 
factor at rated load is close to 1 and is kept at high level for any 
possible operational conditions.

Brightness steps 5 standard, 8 maximum, fully adjustable in 65k levels (1mA resolution)

Output current [A] 6.6

Remote control and monitoring - Multiwire: 48 to 60 V DC
- Single or dual J-Bus protocol over RS485/RS422
- Single or dual J-Bus protocol over Ethernet IEEE 802.3

Regulation response time - Less than 0.3 seconds
- Exceeds the requirements of IEC 61822

Open circuit ouput voltage Less than 1.2 times the nominal output voltage (RMS)

Ingress protection IP 21

Type Rated output 
power  [kW]

RMS output 
voltage at 6.6 A 
RMS output 
current [kV]

Insulated test on 
outputa  [kV]

Output overvoltage 
protection 25kApk

VIS 2.5 2.5 0.38 3 0.75 kVRMS, 1.4 kJ

VIS 4.0 4.0 0.60 5 1.5 kVRMS, 2.8 kJ

VIS 5.0 5.0 0.75 5 1.5 kVRMS, 2.8 kJ

VIS 7.5 7.5 1.13 6 2.2 kVRMS, 4.2 kJ
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12.2 Applicable standards
The equipment is in accordance with these standards:
 

Table: 12.3 Applicable standards

12.3 ElectroMagnetic Compatibility (EMC)
The equipment is designed to operate in an industrial electro-magnetic environment. The regulator complies 
with IEC 61822, in accordance with IEC 61000-6-4 and IEC 6-6-2 (generic standard for industrial 
environment). The equipment is, with adapted test levels, in accordance with IEC/TS61000-6-5, G 
(substation environment, location G).

VIS 10 10.0 1.50 10 2.2 kVRMS, 4.2 kJ

VIS 15 15 2.30 12 3.0 kVRMS, 5.6 kJ

VIS 20 20 3.00 15 4.5 kVRMS, 8.4 kJ

VIS 25 25 3.80 19 5.2 kVRMS, 9.8 kJ

VIS 30 30 4.54 23 6.0 kVRMS, 11.2 kJ

a) Test condition: 50 Hz sinosoidal wave for 1 minute. The test is done without output overvoltage protections.

Type Rated output 
power  [kW]

RMS output 
voltage at 6.6 A 
RMS output 
current [kV]

Insulated test on 
outputa  [kV]

Output overvoltage 
protection 25kApk

Standard Description

ICAO Aerodrome Design Manual, Part 5 paragraphs 3.2. 
(current edition)

FAA a AC 150/5345-10 (current edition), L-828 and L829 
except for input voltage

IEC IEC 61822

CENELEC EN61822

CE certfied

a) The equipment is not an FAA equipment but it complies with most of the FAA requirements.
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12.4 Dimensions and mass
The small cabinet (A) and the big cabinet (B):

 

Table: 12.4 Dimensions

 

Table: 12.5 Mass

A

B

Z

Z

Y XXY

Item A - 2.5 kVA A - 4 to 15 kVA B - 20 to 30 kVA

X [mm] 420 420 520

Y [mm]a 550 840 840

Z [mm] 1300 1300 1600

a) Depending on the output power connection (options)

Type Net mass Crate mass Crate dimensions width 
x depth x height [mm]

2.5 140 23 1200 x 800 x 1500

4 180 23 1200 x 800 x 1500

5 190 23 1200 x 800 x 1500

7.5 215 23 1200 x 800 x 1500
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12.5 Protection devices
 

Table: 12.6 Protection devices specifications

12.6 Used brightness steps
All equipments are programmed with five steps by default. You can change the number of required steps. 
Table 12.7 shows the current values that the equipment produces at each step, depending on how many 
steps are programmed.

Example:
The equipment is set to five brithness steps. The default current value set for step 3  is 4.1 A.
 

Table: 12.7 Current values produced at each brightness step

10 255 23 1200 x 800 x 1500

15 285 23 1200 x 800 x 1500

20 360 40 1200 x 800 x 1850

25 410 40 1200 x 800 x 1850

30 450 40 1200 x 800 x 1850

Type Net mass Crate mass Crate dimensions width 
x depth x height [mm]

Equipment type 
[kVA]

Equipment  
voltage [V]

Main fuse rating 
[A]

Manual switch 
type C rating [A]

Maximum line 
input current [A]

2.5 380 to 400 16 10 5.9

4 16 16 9.4

5 16 16 11.7

7.5 20 20 17.6

10 50 40 23.4

15 50 40 35.2

20 80 80 46.9

25 80 80 58.6

30 100 100 70.3

Brightnes
s step

Default current value [A] 

No. of steps used

3 4 5 (default) 6 7 8

1 4.8 3.3 2.8 2.7 2.2 2.8

2 5.5 4.4 3.4 3.4 2.8 3.1
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These values apply when the minimum current is 2.8 A and the maximum current is 6.6 A.

3 6.6 5.5 4.1 3.9 3.4 3.4

4 6.6 5.2 4.5 4.1 3.9

5 6.6 5.4 5.2 4.6

6 6.6 6.4 5.5

7 6.6 6.4

8 6.6

Brightnes
s step

Default current value [A] 

No. of steps used

3 4 5 (default) 6 7 8



140 A.07.375e - Edition 2.0

Technical data

12.7 Ambient conditions
The equipment is air-cooled with fans. Thus, the equipment must have a good airflow, especially if they 
operate near the maximum temperature.

 

Table: 12.8 Ambient conditions

12.8 Parts list

12.8.1 Part orders

Part orders
Each part of the equipment has a part number. When you order parts:
- Always mention the part number of the ordered part;
- Always mention serial number and type of the equipment. These are indicated on the nameplate of the 

equipment.

For all spare part orders, contact ADB Safegate or the local representative of ADB Safegate.

Recommendations
To reduce downtime during maintenance, have one or more extra equipment cabinets in stand-by at the 
substation. This is especially important at major airports, which have a large amount or equipments. 
Keep spare parts always in stock. For example:
- Fuses;
- Lightning arrestors;
- PCBs.

Item Description

Temperature From -20 up to +55 °Ca

Altitude From 0 (sea level) up to 1000 meter

Relative humidity From 10% up to 95% RH without condensation

a) For IEC conformity to -40 °C an optional modification is required.

WARNING
Use only original ADB Safegate spare parts.
If you use other spare parts, the specific module or the equipment may be damaged. This 
can also put the personnel in danger.

Note
The parts list may be subject to change without prior notice. Contact ADB Safegate to 
obtain the latest version.
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12.8.2Preventive spare parts
 

 

Table: 12.9 Preventive spare parts - Main fuse

 

Table: 12.10 Preventive spare parts - Main contactor

Item Table

Main fuse 12.9 Preventive spare parts - Main fuse

Main contactor 12.10 Preventive spare parts - Main contactor

Lightning arrestors 12.11 Preventive spare parts - Lightning arrestors

Overvoltage protection 12.12 Preventive spare parts - Overvoltage protection

Capacitors 12.13 Preventive spare parts - Capacitors

Safety switches 12.14 Preventive spare parts - Safety switch

Fan 12.15 Preventive spare parts - Fan

IGBT bridge 12.16 Preventive spare parts - IGBT bridge

Micro control PCB 12.17 Preventive spare parts - CPU PCB

Output measure PCB 12.18 Preventive spare parts - Output measure PCB

Power supply PCB 12.19 Preventive spare parts - Power supply PCB

Remote control PCB 12.20 Preventive spare parts - Remote control PCB

Diode bridge PCB 12.21 Preventive spare parts - Diode bridge and sensing PCB

IGBT PCB 12.22 Preventive spare parts - IGBT PCB

Precharge PCB 12.23 Preventive spare parts - Precharge PCB

Ethernet adapter 12.24 Preventive spare parts - Ethernet adapter

Display and keyboard 12.25 Preventive spare parts - Display and keyboard

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30
Fuse 16A 10X38 aM 6130.20.150 3 3 3

Fuse 20A 10X38 aM 6130.20.160 3

Fuse 50A 14x51 aM 6130.20.210 3 3

Fuse 80A 22x58 aM 6130.20.280 3 3

Fuse 100A 22x58 aM 6130.20.300 3

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Contactor   LC1D12B7 6148.46.030 2

Contactor   LC1D32B7 6148.46.000 2 2 2 2

Contactor   LC1D40B7 6148.46.010 2 1 1 1

Contactor   LC1D80B7 6148.46.020 1 1 1
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Table: 12.11 Preventive spare parts - Lightning arrestors

 

Table: 12.12 Preventive spare parts - Overvoltage protection

 

Table: 12.13 Preventive spare parts - Capacitors

 

Table: 12.14 Preventive spare parts - Safety switch

 

Table: 12.15 Preventive spare parts - Fan

 

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Lightning arrestor SIOV 
B72232-B751-K1

6314.32.750 2 4 4 4 6 8 10 12 14

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Overvoltage protection 
V480LA80BP

6314.12.286 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

CAP.  PPA1854100KN  
polypropylene film +

6322.60.240 2 2 2 2

CAP. PMC1704500KVR  
5uF/700V step 20-25+

6322.60.220 2 2 2 2 2

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Doorswitch EPS: 684 6150.49.060 3 3 3 3 3 3 4 4 4

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

CCR FAN 120x120x38  
24vdc ball bearing

7074.10.100 2 6 6 6

CCR FAN connect.cable 
(15kVA 

6100.15.300 1
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Table: 12.16Preventive spare parts - IGBT bridge

 

Table: 12.17 Preventive spare parts - CPU PCB

 

Table: 12.18 Preventive spare parts - Output measure PCB

Description Part number Quantity per order

400 V 230 V

2.
5

4 5 7.
5

10 15 20 25 30 2.
5 

ST

2.
5

4 5 7.
5

Semix 202 GB 12E4s 6351.88.040 2 2 2 2 2 2 2 2 2 2 2

Semix 453 GB 12E4s 6351.88.060 2 2 2

ISOLAT.M6 0.6kV 6126.12.485 2 2 2

Semix 341D16s 6351.88.030 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS479/5 CRE/VIS CPU 
pcb:CS00179 rev.1.1

1597.00.000 1 1 1 1

EPS479/15 CRE/VIS 
CPU pcb:CS00179 rev1.1

1597.00.010 1 1

EPS479/30 CRE/VIS 
CPU pcb:CS00179 rev1.1

1597.00.020 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30
EPS442/2.5 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.100 1

EPS442/5 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.110 1 1
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Table: 12.19 Preventive spare parts - Power supply PCB

 

Table: 12.20 Preventive spare parts - Remote control PCB

 

EPS442/7.5 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.120 1

EPS442/10 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.130 1

EPS442/15 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.140 1

EPS442/20 CRE/VIS 
out.meas.board CS0039 
rev.2.2

1597.00.150 1

EPS442/30 CRE/VIS 
out.meas.board CS0039  
rev.2.2

1597.00.160 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS480/30 VIS 
pow.sup.board PCB 
CS00180  rev.1.2 (6 fans, 
with SHVS)

1597.00.230 1 1 1 1 1 1 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS495 CRE/VIS 
communication board 
PCB CS00190  rev.1.2

1597.00.300 1 1 1 1 1 1 1 1 1
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Table: 12.21 Preventive spare parts - Diode bridge and sensing PCB

 

Table: 12.22 Preventive spare parts - IGBT PCB

 

Table: 12.23 Preventive spare parts - Precharge PCB

 

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS540/7.5 VIS5000-08 
PCB CS00228  rev.1.0  
(diode bridge & sensing)

1597.00.441 1 1 1 1

EPS541  10/15   
VIS5000-08 PCB 
CS00229 rev.1.0 (diode 
bridge & sensing)

1597.00.451 1 1

EPS497 CRE20/30 
HAIS150-P interface 
board.CS00192 rev.1.0 
(sensing without diode 
bridge)

1597.00.500 1 1 1

EPS476/30 CRE/VIS 20/
30KVA PCB CS00176 
rev.2.0 (sensing, without 
diode bridge)

1597.00.421 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS477 CRE/VIS 2.5/
15KVA PCB CS00177 
rev.1.1 (IGBT driver)

1597.00.510 2 2 2 2 2 2

EPS478 CRE/VIS 2.5/
15KVA  PCB CS00178 
rev.1.0

1597.00.520 1 1 1 1 1 1

EPS496 CRE/VIS 20/
30KVA PCB CS00191 
rev. 1.0

1597.00.530 2 2 2

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS546/10  VIS5000-08 
4/10KVA   CS00234 rev. 
1.0 (precharge board)

1597.00.540 1 1 1 1 1 1 1
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Table: 12.24 Preventive spare parts - Ethernet adapter

 

Table: 12.25 Preventive spare parts - Display and keyboard

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EPS542 CRE/VIS 
ethernet and single 
ethernet adapter PCB 
CS00230 rev.1.0

1597.00.600 1 1 1 1 1 1 1 1 1

EPS542 CRE/VIS 
ethernet and double 
ethernet adapter PCB 
CS00230 rev.1.0

1597.00.610 1 1 1 1 1 1 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

CCR KEYBOARD BOX 
ASSY. TRIPHASE

4072.30.630 1 1 1 1 1 1 1 1 1
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12.8.3Corrective spare parts
 

 

Table: 12.26 Corrective spare parts - Manual switch

 

Table: 12.27 Corrective spare parts - Main fuse housing

 

Item Table

Manual swiitch 12.26 Corrective spare parts - Manual switch

Main fuse housing 12.27 Corrective spare parts - Main fuse housing

Line filter 12.28 Corrective spare parts - Line filter

Output Filter 12.29 Corrective spare parts - Output filter

Capacitors 12.30 Corrective spare parts - Capacitors

Precharge resistors 12.31 Corrective spare parts - Precharge resistors

Main transformer 12.32 Corrective spare parts - Main transformer

Fan connector cable 12.33 Corrective spare parts - Fan connector cable

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

S203-C10 6150.90.740 1

S203-C16 6150.90.540 1 1

S203-C20  6150.90.550 1

S203-C25 6150.90.570

S203-C40 6150.90.620 1 1

S203-C50 6150.90.590

S293-C80 6150.90.650 1 1

S293-C100 6150.90.660 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Fuse housing 32 6150.90.670 1 1 1 1

Fuse housing 50 6150.90.730 1 1

Fuse housing 125 6150.90.680 1 1 1
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Table: 12.28 Corrective spare parts - Line filter

 

Table: 12.29 Corrective spare parts - Output filter

 

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

EMK3012 (3Ph 10 400V) 6115.18.100 1

EMK3020 (3Ph 20A 
400V)

6115.18.110 1 1 1

EMK3040 3Ph 40A/400V 
line filter

6115.18.080 1 1

EMK3050 6115.18.150

EMK3070 (3Ph 70A/400V 
line filter

6115.18.160

EMK3100  (3 Ph 100A 
400V)

6115.18.140 1 1 1

Toroidal inductor 13mH/
10A

6166.50.330 1

Toroidal inductor 16,5mH/
16A

6166.50.340 1 1

Toroidal inductor 10mH/
35A

6166.50.320 1

Inductance 10mH/40A  
code:1212

6166.50.300 1 1 2 2 2

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30
Toroidal inductor 750uH/
15A

6166.50.350 2 2

Inductance 285uH/40A 6166.50.310 4 6 6 6 12 12 12

CAP. PMC1704500KVR  
5uF/700V step 20-25+

6322.60.220 2 2 2 2 2

CAP.30uF 400V Ecofill 
MLR25PRL 453004591

6322.60.300 1 1 2 2 2 3 6 8 8
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Table: 12.30 Corrective spare parts - Capacitors

 

Table: 12.31 Corrective spare parts - Precharge resistors

 

Table: 12.32 Corrective spare parts - Main transformer

 

Table: 12.33 Corrective spare parts - Fan connector cable

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

CAP.   AYUX-
HR472M400DF1 LBK-Int. 
4700uF/400V M12

6322.60.200 2 2 2 4 4 6 8 8

CAP.  AYUX-
HR222M400DC LBK Int. 
2200uF/400V M12

6322.60.210 2 2

Description Part number Quantitity per order
2.

5

4 5 7.
5

10 15 20 25 30

Resistor 15K/10W a filo 
smaltata EPS:529

6310.60.200 2 2 2 2 2 2 6 8 8

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

Transf.400Vac out:24V 
ref:524108

6300.03.430 1 1 1 1 1 1 1 1 1

Transf.100VA 400V/24V-
94VA/24V-6VA 

6300.03.400 1 1 1 1 1 1

Transf.200VA 400V/24V-
6VA/24V-194VA

6300.03.410 1 1 1

Description Part number Quantitity per order

2.
5

4 5 7.
5

10 15 20 25 30

CCR FAN connect.cable 
(15kVA )

6100.15.300 1
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